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Shifting Perceptions
Collectively, we are creating a new GIS reality—what Jack Dangermond, Esri’s president,
has described as a new modality. Th is new modality embraces the traditional GIS infrastructure that has been developing over the last 30 years and the rapidly emerging and
more informal infrastructure that is being built around information gleaned from search
and location interaction. The web is bringing these two infrastructures together and allowing them to interact with and enrich each other.
When an existing method for accomplishing a task is replaced by a new technology, the
initial response is to try to make that new technology ape the old one. The fi rst word
processing programs were conceptualized as typewriters with screens. While these programs offered some advantages (it was easier to find and correct errors), it took a surprisingly long time for software companies to stop re-creating typewriter programs and
start making programs that capitalized on the tremendous potential for interacting with
information contained in a document by manipulating the text in various ways.
The development of GIS followed a similar pattern. The fi rst digital maps, which were
largely CAD based, automated the creation and distribution of maps but offered little potential for interacting with the information. With the creation of GIS data models, many
different questions could be asked and answered in different maps using the same data.
Th is approach shared not just data but knowledge. It represented a new modality—one
that has been successfully used for several decades.
A new GIS modality now emerging is driven by advances in technology, software, and
science; the adoption of open data sharing policies; and an expanding network of sensors
measuring everything from stream flows to the traces of cell phones and making that
data available in real time. The combination of pervasive platforms like mobile and web
has transformed GIS by giving more people greater access to geographic information and
fostering a myriad of new ways of interacting with that information. It is creating an
ecosystem of knowledge that can affect how not only governments and business but also
individuals.
While this shift will tremendously affect society at large, it will have pronounced effects
on GIS practitioners. As Dangermond has observed, “So you, in the geospatial field, from
the executive down to the technician, are working in a field that’s growing very fast. It’s
emerging and will provide a new kind of knowledge for us to behave and evolve into the
future.”
Welcome to the geospatial ecosystem.
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ith the ArcGIS Viewer for Flex,
you can easily create fully functional GIS applications on the
web. Your GIS maps and analytic tools
can be accessed by users inside and outside your organization with a simple web
browser.
This configurable application can be
downloaded and set up in a matter of minutes and includes many core GIS mapping
functionalities: data display, map navigation, query and search, simple markup,
printing, and data editing. The viewer’s
look and feel, analytic capabilities, and
data content can be customized to specific business needs without writing a single
line of code. If you have ArcGIS Server and
want to quickly and easily create powerful web mapping applications, this is the
product for you.
ArcGIS Viewer for Flex is a configurable
web client application built on the ArcGIS
API for Flex that enables you to quickly
and easily create powerful GIS mapping
applications for the web. It is a browserbased viewer designed to work with
ArcGIS Server and ArcGIS Online services.
The viewer application is hosted on premises and includes many core GIS mapping
functionalities. It supports the latest capabilities offered by ArcGIS Server and
has minimal system requirements: a web
browser with the Adobe Flash Player
plug-in installed and web server software
to make the viewer available as a web
resource. It is built with the latest Adobe
Flash Builder 4 technology and practices.
Distinct from the other viewer options
offered by Esri, ArcGIS Viewer for Flex is
configurable and hosted on premises. The
ArcGIS.com viewer and ArcGIS Explorer
Online, two other client viewers, are not
configurable and are hosted by Esri.
The ArcGIS Viewer for Flex Resource
Center is the main source for getting
more information about the application. It
contains all the resources needed to start
working with the viewer including
• Links to the viewer application download packages
• Help and developer documentation
• Sample application configurations and
live widget samples
• A link to the support forum

4
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Reasons to Use

Configurable viewer for ArcGIS Server and ArcGIS Online services
By Derek Law, Product Management

REASON 1

REASON 2

The viewer can be used
immediately out of the box.

The viewer can be configured;
no programming is needed.

Getting started with the ArcGIS Viewer for
Flex is a simple 1-2-3 process:
1. Download
the
compiled
viewer
application.
2. Unzip the download package.
3. Place the contents of the download package (a single installation folder) in a web
server resources directory.
The entire process takes six to eight minutes. Once these three steps are complete,
the ArcGIS Viewer for Flex application is
ready for use. By default, it is preconfigured
to access services from ArcGIS Online, so
you can start to explore the viewer’s capabilities immediately.
It is easy to get started with the viewer.
It fully supports ArcGIS Server functionality and web services. Viewer functionality
includes support for basemaps, operational
layers, dynamic legends, data query, search,
GeoRSS feeds, drawing, time-aware data,
and data editing. It also works with maps
created and shared with the ArcGIS.com
viewer, so you can use the ArcGIS Viewer for
Flex with shared maps published online.

The viewer’s look and feel, functionality,
and data content can be easily customized
without any programming. The viewer configuration is designed with the nondeveloper in mind. You simply edit XML fi les to
configure the viewer to meet your specific
business requirements. A few simple edits
to the application configuration fi le enable
the viewer to work with your web services.
Th is means an organization can brand and
customize (e.g., use a company logo, custom
data, and appearance) its web client applications with minimal effort—no programming
or developer resources are needed.
Behind the scenes, viewer architecture
has a plug-and-play design; its user interface
and functionality are based on widgets (i.e.,
modular code chunks) that can be assembled
in building-block fashion to create custom
web client applications. The viewer’s user
interface and functionality can be changed
by simply referencing different widgets in its
application configuration fi le. Configuring
the viewer makes it easy to create custom
applications. Conceptually, the viewer is
similar to a site starter template used for
creating web client applications quickly, so
it is an ideal solution for prototyping application solutions. For examples, see the live
user sites at the ArcGIS Viewer for Flex Live
Sites group on ArcGIS.com.

Software and Data

the ArcGIS Viewer for Flex

REASON 3

REASON 4

REASON 5

The viewer has an extensive
widget library.

The viewer framework is
extensible with the ArcGIS API
for Flex.

The viewer is free and fully
supported by Esri.

Widgets define the viewer’s appearance and
functionality. The viewer application comes
with 20 widgets that provide many core
GIS mapping functionalities. These widgets can be used in various combinations
to create different, focused web mapping
solutions. In addition, an online gallery of
developer sample widgets contributed by
the viewer user community and developer
sample widgets provided by Esri staff and
users is available in the code gallery of the
ArcGIS Viewer for Flex section of the ArcGIS
Resource Center. All widgets can be downloaded for free and used in viewer applications. As more people use the viewer, the
number of widgets in this library will continue to increase.

The viewer is built on the ArcGIS API for Flex,
and both the viewer and API follow a concurrent release schedule. When a new version of
the Flex API is released, a new version of the
viewer built on the new API is also released.
Each version released supports the latest
functionality available in ArcGIS Server. The
viewer source code is also available online,
enabling developers who are familiar with
the Flex API to further customize the viewer.
Developers can extend the existing viewer in
several ways by
• Modifying or enhancing the behavior of
existing widgets
• Creating new widgets (i.e., new functionality) from scratch
• Extending the core viewer framework for
a more customized client application
Some widgets in the widget gallery also
include source code that can be leveraged
by developers to meet specific business/application needs. Th is makes the viewer an
extensible ArcGIS Server web client application for users who want advanced customization options.

The ArcGIS Viewer for Flex application and
its source code are available as free downloads for existing ArcGIS Server users. Th is
configurable client application is provided
at no cost. It is frequently updated to support the latest ArcGIS Server capabilities
and is fully supported by Esri. Users can call
Esri Support and get technical assistance
with the viewer when needed.

esri.com Spring 2011 au

5

Meeting
Many Needs
Geoportal aids users and contributors
By Jessica L. Zichichi, Vice President, Geospatial Solutions Group, Innovate!, Inc.,
and Michelle A. Torreano, Agency Geospatial Metadata Coordinator, US EPA

A comprehensive geospatial metadata sharing and management framework implemented at
the US Environmental Protection Agency (EPA) is promoting transparency, participation, and
collaboration in government while meeting user, agency, and federal requirements.
A Gateway for Contributors and
Consumers
The GDG is the central gateway to EPA’s geospatial resources. It enables data consumers
to discover, view, and access geospatial resources (e.g., data, services, or applications).
Likewise, it enables EPA data contributors
to publish and manage their geospatial information for others to use.
GDG maintains a repository of metadata
about the geospatial resources users are seeking to discover or make available. Metadata
records in the repository describe the nature
and scope of registered data items or services
and provide information that enables users to
locate and view them. Metadata descriptions
also provide information necessary to access
items and services for use in other systems or
mapping applications.

The search widget lets users
search GDG and obtain
formatted results within their
own applications.
Hundreds of agency geospatial resources
are available to the public from the GDG.
These resources are added and managed in
GDG by EPA regions, programs, and labs
from across the agency—organizationally
and geographically—using a defined governance structure.

6
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A Comprehensive Framework

Serving Users

GDG was implemented as a comprehensive
geospatial metadata sharing and management framework to meet multiple user,
agency, and federal requirements. Since
geospatial data has a prominent role in
government decision making, EPA thought
this data should be maintained as a shared
enterprise resource that would provide end
users with multiple benefits. For example, properly documenting and managing
agency geospatial resources would ensure
that federal metadata maintenance and
sharing requirements were met.
Creating GDG also allowed the EPA to
have a single access point for these resources
and provided users with a comprehensive
view of the agency’s geospatial assets. This
reduced the time users spent searching
across multiple locations and data redundancy by connecting data producers with
consumers, thus preventing duplication of
effort.
It also has allowed contributors to reuse
information to support their mission goals
by embedding content directly into their
applications. This not only saves time and
money but also provides better consistency across the agency. This catalog also
streamlines EPA’s contributions to external
metadata sharing portals by being the single
source for contributions to Geospatial OneStop (GOS) and Data.gov.

EPA generally groups GDG functions into
two categories: functions that support GDG
consumers and functions that support GDG
contributors.
Consumers can access GDG resources in
a number of ways. One of the most common
methods is a simple keyword search using
the tool located on the GDG home page for
accessing GDG resources. This tool returns
an interactive list of matching metadata records from the GDG catalog.
Users can hover over list items to see more
information about a resource and view its
footprint in the GDG map viewer. Data can
then be previewed or accessed, other details
on the resource viewed, or a search further
refined.
With the advanced search features in the
same interface, users can limit results by
specific content type, data category, or time
period. Advanced users may also perform
more targeted searches in this same interface employing Lucene search syntax that
allows the specification of additional operators or metadata fields. The combination of
these search methods lets users search for
exactly what they want.
Consumers can easily embed results into
web applications or pages using the GDG
REST interface. Links to REST outputs are
displayed for users each time they perform
a search so REST URLs can be reused.

Software and Data

Consumers can access GeoRSS, HTML, or
KML outputs. REST URLs can be configured using additional parameters to narrow
or expand the search results to create outputs in a wide variety of metadata views and
access points to suit a variety of needs.
The search widget, another useful feature,
lets users search GDG and obtain formatted
results from within their own applications.
The search widget can be embedded simply
by copying two lines of code into a web page.

Serving Providers
The GDG metadata management suite
gives contributors tools to manage content.
Contributors can control how and how frequently (where applicable) records are contributed to the central catalog, control how
they are furnished to different types of users,
and control which records belong to which
user groups. GDG contributors can contribute metadata using either automated (harvesting) or manual (upload) methods. Once
metadata has been contributed, users can
log in and manage individual records. A key
function of metadata management in GDG is
the ability of users to identify which records
should be made available to the public (unrestricted) and which should be labeled as
internal only (restricted). Each contributor
can apply this setting to individual records.
Records identified as unrestricted are made
available to all general public users through
GDG and are automatically contributed to
GOS and Data.gov. Restricted records are
only available to GDG consumers that have
logins.

Rather than setting up separate logins
and passwords for GDG, EPA used the
agency’s enterprise IAM system to control
user logins, group membership, metadata
ownership, and access. Using this system
automates group membership for basic
metadata access for EPA employees and
contractors and reduces tasks associated
with ID and password management for
GDG administrators as well as reducing the
number of logins and passwords that EPA
staff must memorize.
EPA structured groups at the IAM system
to control how metadata is managed. Each
GDG contributor is assigned to a particular
regional or program office group to oversee
metadata management for that group (e.g.,
EPA’s Office of Water [OW]). Individuals
are also assigned to functional groups (e.g.,
GDG reader, GDG steward, or GDG administrator) that control functional rights. When
users log in at the GDG, they are provided
with the appropriate metadata management functions so they can modify records
based on their group membership. GDG
contributors can belong to as many groups
as necessary.

The intranet-based REST URL is another
customization that automates authentication
for EPA intranet users. GDG’s default REST
interface honors metadata access levels. If a
user is not logged into GDG, they can view
only unrestricted records when using the
basic REST URL. The intranet-based REST
URL allows users with access to the EPA intranet to view the full set of GDG metadata
records (restricted and unrestricted) without
logging in separately at GDG. This lets EPA intranet users have access to the full set of their
user groups’ records at the GDG using the
REST interface from within other intranet
web applications and web pages. Because the
intranet URL is only available to those who
can access the EPA intranet, this provides
EPA with a secure way to provide access to
all GDG metadata records using the power
of the REST interface while maintaining the
security of the original Internet-based REST
URL, which requires authentication.
Finally, a harvesting extension tool called
WAFer provides EPA with a mechanism
to pull records directly from contributors’
ArcSDE databases. Many EPA personnel
wanted a direct connection so metadata

Meeting Specific Agency Needs
Although EPA was able to utilize many of the
basic features provided by Esri’s Geoportal
extension for ArcGIS Server software, the
agency also worked to customize the application to best meet its needs. One key customization was to structure GDG access and
metadata management using the agency’s
central Identity and Access Management
(IAM) system.

 Simple search interface
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records stored in databases could be viewed
rather than having a separate location for
these records. In addition, the rgw standard
harvester in the Geoportal extension for
ArcGIS Server was configured such that it
required that EPA connect from a publicly
available server to a number of intranet-only

gov and using the search and discovery
resources there, and embedding GDG components in web applications. User input and
recommendations will be key to the future
success of the application. Provide feedback
at geogateway.epa.gov/geoportal/catalog/
identity/feedback.page.

For More Information
Jessica L. Zichichi
Vice President, Geospatial Solutions Group
Innovate!, Inc.
774-487-0445
jzichichi@innovateteam.com
Michelle A. Torreano
Geospatial Metadata Coordinator
US Environmental Protection Agency
202-566-2141
torreano.michelle@epa.gov

About the Authors

 GeoRSS output

servers, which would not have been acceptable for EPA security. The agency developed
the WAFer tool to serve as a single access
point from the public GDG server and relay
all harvesting to internal EPA servers.
WAFer produces a web-accessible folder
(WAF) for each back-end endpoint. These
WAFs are then made accessible to the public
GDG server using a single protocol and base
URL. This allows EPA to connect to a single
internal computer and extends the back-end
connection types that can be harvested,
such as ArcSDE databases and FTP sites.
The agency could maintain harvesting from
a public GDG server while also extending
harvesting in a way that was critical for GDG
contributors.

Soliciting Feedback
GDG is a public resource. EPA encourages public involvement with the GDG.
Individuals can use GDG resources by visiting the GDG website at geogateway.epa.
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What’s Next?
Federal agencies are being asked to take
specific actions to implement the principles
of transparency, participation, and collaboration enunciated in President Barack
Obama’s Memorandum on Transparency and
Open Government. As part of this effort, EPA
has focused on documenting nongeospatial
data for sharing. Because of its success, GDG
will be extended to become the central location for exchanging and managing metadata
for all agency datasets. An expanded GDG
will allow contributors to easily manage and
publish metadata for various types of data
at a single location and will serve as a central access point for internal users, external
users, and interagency data sharing applications. An expanded GDG will advance EPA’s
ability to meet its mission goals by providing an improved framework for data sharing
that increases reuse of resources, promotes
transparency, and facilitates data exchange
across the agency and with external parties.

Jessica Zichichi has been working in the field
of GIS for more than 13 years. She holds a
master’s degree in computer science and
bachelor’s degrees in geography and environmental studies. Her GIS experience
ranges from basic mapping and cartographic production to desktop and web-based
geospatial application development and
programming. Zichichi’s recent GIS efforts
have been focused on enterprise geospatial
solutions, geospatial metadata, and policy
and planning.
Michelle Torreano is the geospatial
metadata coordinator for the US EPA. She
leads the implementation of the agency’s
geospatial metadata management framework, as well as coordinates with interagency data sharing groups. With the US
EPA since 2001, she has worked on a variety
of projects to advance the agency’s National
Geospatial Program, including system
management, geospatial data acquisitions,
and policy development. Torreano graduated from Purdue University with a degree
in natural resources and environmental
science.

GDG Resources
GDG REST URL https://geogateway.epa.
gov/geoportal/webhelp/en/geoportal_931/
GDG_REST_URL_Options.pdf
GDG search widget https://geogateway.
epa.gov/geoportal/catalog/components/
components.page
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Moving GIS from the
Office to Mobile Devices
App and API for Windows Phone 7
Access sophisticated mapping capabilities on Microsoft Windows Phone 7 with the new
ArcGIS for Windows Phone app. With this app, find, use, and share maps as well as deploy
GIS data and functionality. The free app can be downloaded directly from Microsoft’s Zune
Marketplace. ArcGIS for Windows Phone is a mobile gateway to the ArcGIS system. In addition to finding places and addresses and querying map layers and data, the app can collect,
edit, and update features and attribute information for field data collection and inspection
projects. Download and install the app from the desktop using Zune or install it directly from
the phone using the Windows Phone Marketplace.
Esri has also released the ArcGIS API for Windows Phone. With this API, developers can
build interactive applications that combine mapping resources, such as maps, locators, and
geoprocessing models, with Windows Phone technologies and frameworks. Available at no
cost from the ArcGIS Resource Center, this API is supported by a detailed blog, forum, and
code samples.
Built on the Silverlight framework for the Windows Phone application platform, it uses
familiar Microsoft tools and technologies such as Visual Studio and Expression Blend.
Developers already familiar with Silverlight can create new applications for Windows phones
without experiencing a steep learning curve. The ArcGIS API for Windows Phone and ArcGIS
API for Microsoft Silverlight/Windows Presentation Foundation (WPF) have the same architecture, so application logic can be reused in ArcGIS applications built for Windows Phone,
web, and desktop applications.
The ArcGIS API for Windows Phone enables users to go beyond basic mapping. With this
API, developers can build applications that use their own authoritative data, display data on
an ArcGIS Online or Bing Maps basemap, add graphics and markups to a map interactively,
search by GIS feature or attribute and display the results, and execute a GIS model using
ArcGIS Server and display the results.
The API is designed to use web services available from ArcGIS Server and ArcGIS Online.
Developers and Esri partners can build applications that work with their own published web
services that can be deployed within an organization or to the public via the Marketplace.
To learn more about the ArcGIS for Windows Phone app, visit esri.com/windowsphone. To
download and begin building custom applications using the ArcGIS API for Windows Phone,
visit the ArcGIS Resource Center.

Esri Viewer and Updated
Demographics Available
from Windows Azure
DataMarket
A free, online web application developed by Esri for mapping geographic
datasets is hosted in the Windows
Azure DataMarket. The ArcGIS
Geospatial viewer, based on the
ArcGIS API for Silverlight, lets visitors
to the site map and analyze geoenabled data in the DataMarket including
Updated Demographics from Esri.
Windows Azure DataMarket is
a cloud service that provides a
global marketplace for delivering
high-quality information in a consistent manner. Microsoft has selected
ArcGIS as a foundation for viewing
geospatial information in the DataMarket. Application developers and
end users can select data, view it on
a map, and analyze it with advanced
geospatial tools from Esri to make
better, more informed decisions.
Variables from Esri’s Updated Demographics (2010/2015) data are available from the DataMarket. Developed
with industry-leading, benchmarked
methodologies, this demographic
data identifies areas with characteristics such as high unemployment, rising
vacancy rates, reduced consumer
spending, changes in income, and
increased population diversity. For
more information, visit esri.com/software/landing_pages/microsoft/azure.
html. For more information about
Esri’s Updated Demographics, visit
esri.com/demographicdata.
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Shareable and Usable
Geographic Knowledge

Focus

GIS systems are emerging that connect all
types of devices to a virtual warehouse of
geographic information. Instead of using
GIS just on the desktop or a mobile device,
these systems encompass not only data but
services, maps, apps, analytic models, data
models, and workflows that make information accessible and actionable. In this
emerging ecosystem of knowledge based
on geographic information, using ArcGIS
doesn’t mean just using GIS software.
ArcGIS is the key to vast resources for collaborating on, interacting with, analyzing,
and sharing information.
This approach employs multiple maps
generated from transactionally maintained
databases that can help formulate answers to some of the seemingly intractable
questions facing the world and foster new
perspectives.
Rather than being a departure from traditional GIS, this approach to the use of
geographic information represents part of a
logical progression from the desktop to the
network that has now pushed out beyond
the boundaries of individual agencies or
companies. It expands the role of the GIS
professional who not only continues creating and maintaining geospatial data and authoring maps but now also creates services
and focused apps that make geographic
knowledge that is shareable and usable.
The enhanced ability to use data sources
has been vitally important to this transformation. Initially, scanned maps and aerial
photography were the primary geospatial
data sources. Now data sources have expanded to include satellite imagery; lidar
returns; CAD data; and real-time measurements of traffic, earthquakes, stream flows,
and many other phenomena by networks
of sensors capturing them as well as media
such as photos and video.
The popularity and growth of ArcGIS

Online demonstrates how rapidly this new
ecosystem of geographic knowledge is
evolving. In just a few years, it has grown to
become a repository for more than 45,000
maps, apps, and other resources and has
35,000 registered users. These users can
access content derived from commercial
and other authoritative sources, such as web
maps, map services, apps, and layer/map
packages, using ArcGIS or a web browser.
Content is constantly added. Beginning
in 2011, ArcGIS Online basemaps (esri.com/
mapservices) can be used without a subscription whether for commercial or noncommercial use inside or outside an organization.
This policy change includes World Imagery
Map, World Street Map, World Topographic
Map, USA Topographic Maps, and DeLorme
World Basemap. The only restriction is a
high-volume transaction limit of 50,000,000

transactions in a 12-month period for nongovernment users. This volume is equivalent
to 400,000,000 tile requests per year or more
than 1,000,000 requests per day—a volume
very few users will likely reach. This year,
the site is also making the vast archive of
Landsat imagery available as map services.
(For more information, see “Over Time, Over
the Globe: Landsat imagery archive made
broadly available” in this issue.)
Not only have the volumes and types of
spatially referenced data increased but also
the ability of more people to interact and
manipulate that data. Moving to pervasive
platforms like mobile and web has had a
tremendously transformative effect on GIS.
It has meant more access by more people
more of the time. It is more than just new
data sources—there are new ways of interacting with geographic information.

 Volunteered geographic information (VGI) applications have harnessed social media

feeds to aid response to events such as the earthquake in Christchurch, New Zealand.
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The impact of volunteered geographic
information (VGI) illustrates contributions
that this geospatial ecosystem is making
by enabling cooperation and better understanding of complex events. VGI applications have harnessed social media feeds,
such as Twitter, YouTube, and Flickr, to
respond to events that range from coordinating rescue efforts in emergencies such as
the floods in Queensland, Australia, to understanding rapidly evolving situations such
as the antigovernment protests in Tahrir
Square that led to the revolution in Egypt.
At the same time, decision support apps
that make information directly accessible
by leaders are being created. Scheduled for
release in April 2011, Community Analyst is
an example of a web-based, GIS-enabled solution for nonexperts that provides decision
support for leaders, government agencies,
and organizations. Its online data and tools
are simple, so users can easily explore and
analyze data for any geography including
census block groups and hand-drawn areas.
Through the map, thousands of demographic, health, economic, education, and
business data variables can be accessed.
Data can be mapped thematically and

displayed with imagery. Any modifications
to parameters are immediately shown.
Tapestry Segmentation profile data can be
included that reveals detailed lifestyle and
consumer behavior for neighborhoods in an
area of interest. Up to five customizable criteria can be searched at once with the Smart
Map Search function.
This interactive environment lets decision makers model outcomes by identifying where allocated resources will have the
greatest effect or which people will be affected by a specific decision. By examining
patterns, relationships, and trends in a community, more appropriate strategies and
policies can be developed.
Reports and maps customized to the community can more effectively communicate
those strategies and policies. Community
Analyst can generate print-ready reports,
files in Microsoft Excel, and maps in PDF
format.
In this new environment, a dialog between policy makers and citizens can be enjoined. Presenting information on national
issues and trends in maps along with the
tools to interact with that information supports informed participation in government.

Esri Redistricting, a new online platform, helps engage more US citizens in the
process of redrawing the nation’s political
boundaries by removing the barriers of cost,
data availability, and accessibility. For more
information, see “Opening Up the Process:
Web-based application encourages citizen
involvement” in this issue.
Web mapping is becoming an increasingly common mechanism for government
to communicate with its constituency.
Recovery.com supplies current information on grants and contracts awarded by
the US government through the American
Recovery and Reinvestment Act of 2009
(ARRA). The ability of citizens to interrogate
the map and obtain current information
about specific projects promotes government transparency and accountability.
The new information ecosystem makes
geographically referenced information more
accessible by a greater variety of people who
can share a common operating picture and
work together more effectively. “GIS for everyone” was proposed by Esri president Jack
Dangermond more than a decade ago. In
this new ecosystem of knowledge, it is much
nearer to reality.

PE n n Stat E | On l i n E
Geospatial Education Portfolio
Penn State offers high-quality online education programs
to help you achieve your personal and professional goals.
Master of Geographic Information Systems
Postbaccalaureate Certificate in Geographic
Information Systems
Postbaccalaureate Certificate in
Geospatial Intelligence

w w w.worldc ampu s .p su .e du/ar cu ser 09
U.Ed.OUT 10-0151/10-WC-090edc/bjm
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Focus

Public Service 2.0

Program fosters civic-minded web development

A new nonprofit organization has enlisted some of the nation’s most
talented technologists to build web apps that will help cities work
better.
Code for America has challenged 20 fellows, chosen in January
2011 from a pool of 360 applicants that included web developers,
designers, and entrepreneurs, to work in small teams building applications that will make local governments more open, efficient, and
responsive to citizens. The applications they devise will accomplish
these goals through improving data sharing, enhancing communication between the governed and governing, enabling better decision making, and encouraging community action.
Addressing these problems will call upon not only the technical
skills of fellows but also their leadership abilities. Benefits to fellows
include instruction leading to a practical understanding of municipal government, professional development through mentoring
and networking, and potential employment with leading Internet
companies. Fellows will work with civic and industry leaders for
11 months. The applications developed, which should be lightweight,
cost-effective, efficient, and scalable, will be made available to other
local governments.
In this fi rst iteration of Code for America, four cities—Boston,
Massachusetts; Washington, D.C.; Philadelphia, Pennsylvania; and
Seattle, Washington—were chosen through a competitive process
from dozens of cities that applied to the program. Each city has partnered with a team of fellows to address a specific project.
• In Boston, the city’s educational services will be able to engage
students via a web platform that could provide suggested readings for homework assignments, let students discuss their work
and participate in contests, and other activities.

• Washington, D.C., will create a manual that will assist other local
governments in conducting open data programs like the district’s
own Apps for Democracy contest.
• Helping its citizens collaborate on activities related to neighborhood services is the goal of the Philadelphia project.
• Collaboration is also the theme of Seattle’s project, which is seeking a mechanism for enabling communities to work more effectively with each other and public safety officials.
Esri is supporting Code for America with software and training
and advising fellows in all four participating cities.
As the work of Code for America 2011 goes forward, the organization is seeking more local governments to work with the next cohort
of fellows in developing solutions to problems that are common
across jurisdictions.
Web technologists interested in applying for the 2012 program
should visit codeforamerica.org and begin the process now to
meet the application deadlines. The program provides a unique
opportunity for people who have the skills and passion to contribute
to a new approach to solving the problems of local government. As
Caterina Fake, cofounder of Flickr and Hunch, has observed, Code
for America provides a way of “doing good while you are doing
something you are really good at.”
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OPENING
UP THE PROCESS

WEB-BASED APPLICATION

ENCOURAGES CITIZEN INVOLVEMENT
A new online platform developed by Esri lets citizens
become more engaged in the redistricting process.
District Distribution

 White NH
 Black NH
 Other
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By combining geographic data and tools in an online application, Esri Redistricting
gives state and local governments, the public, and advocacy groups unprecedented
access to the redistricting process. In the United States, political representation is
based on population and location. Ideally, political boundaries are drawn to equally allocate population among the districts in a state so that all citizens obtain fair
representation.
Because people are born, retire, die, relocate, or for other reasons move, the population shifts. To account for these changes, the US Constitution mandates a decennial census. Based on the data collected, district boundaries are redrawn to account
for these changes. Over time, states gain or lose congressional seats, and individual
districts in those states change shape. How these districts are redrawn has a very
real impact on representation for the intervening five congressional cycles. In late
March 2011, the Census Bureau supplied data from the 2010 Census to states so they
could begin the process of evaluating and modifying districts. The 435 seats in the US
House of Representatives are assigned based on a formula that first assigns one seat
to each state then uses each state’s resident population (plus any overseas military
personnel and civilian federal workers and their dependents) to allocate the remaining 385 seats.
Mapping has always been central to the process of redistricting. GIS is the perfect
technology for creating redistricting maps and understanding the effects of boundary changes on associated populations. It’s not surprising that GIS was applied to
both census and redistricting activities as soon as it became commercially available
in the 1980s.
Over the past three decades, Esri business partners built solutions that lowered
the cost and increased the efficiency of the redistricting process. In the 1990s, GISbased redistricting solutions could model as many as 100 scenarios when considering a redistricting plan. The number of potential scenarios that could practically
be considered grew to 1,000 for GIS redistricting applications used with the 2000
Census data.
Legislators, commissioners, and others involved in creating redistricting plans
need to share those plans, solicit feedback, consider alternative plans, and incorporate edits before submitting final plans. However, despite improvements in the tools
used by government officials, involvement by citizens and advocacy groups in the
process was limited.

Focus
Esri recognized this need by developing a web-centric solution that invites larger
participation in a process that was previously much more exclusive. Esri Redistricting
provides a common view of current and proposed districts for state and local government officials, advocacy groups, and citizens. While few public users may pursue their
own redistricting plans, this application enables citizen engagement on a more basic
level by letting the public interact with proposed districts to help preserve communities and ensure representation that reflects community needs.
To provide flexibility in meeting the needs of organizations of different sizes, Esri
Redistricting is available as Software as a Service (SaaS) on a subscription basis or as
a configured offering that can be hosted and managed by Esri or deployed on premises. With either deployment choice, users can create, edit, publish, review, and collaborate on plans through a web browser. Boundaries can be developed that take into
consideration race, existing communities, voting age population, and other variables.
Esri Redistricting includes basemaps (street, imagery, and topographic), census data
from 2000 and 2010, and Public Law 94-171 data. Data from previous censuses, proprietary information, and existing legislative boundaries can be added.

District Statistics

Fracturing/Packing

 District 1
 District 2
 District 3
 District 4

User roles controlling access and functionality can be established. Undo and redo
options for editing tools and the ability to add comments and map notes aid collaboration. Integrity checks validate contiguity, dual assignments, district counts, null
assignments, and population summaries. Esri Redistricting also helps create documentation to verify compliance with Section 5 of the Voting Rights Act, which prohibits discriminatory redistricting practices.
Alabama was one of the first states to adopt this platform and has brought its
entire redistricting process online. The Alabama legislature chose Esri Redistricting
because it could securely incorporate input from many locations without requiring
the state to purchase, install, and maintain desktop software. Plans can be developed,
shared, and evaluated before being submitted to the Reapportionment Office for
final review.
The combination of Internet access and smartphones is creating a new and qualitatively different connection between government and citizens. The Internet has
become the primary entry point for citizen involvement in government processes.
This has led to different expectations of the transparency and responsiveness of
government.
By removing the barriers of technology cost, data availability, and accessibility for
the public and advocacy groups, Esri Redistricting has the potential to make the redistricting process following the 2010 Census one of the most open yet seen. To learn
more, visit esri.com/redistricting. A free 30-day trial is available.
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Over Time,

Over the Globe

Landsat imagery archive

made broadly available

The Landsat imagery archive contains the longest continuous
global record of the earth’s surface. It is an invaluable resource for
dealing with the complex environmental challenges the world faces.
Now, an array of image services and a new viewer developed
by Esri combine to make 30 years of Landsat imagery more accessible to specialists and nonspecialists alike. This fulfills the
promise made by Department of the Interior (DOI) secretary Dirk
Kempthorne in 2008 to make all Landsat scenes available for free.
In the intervening years, Esri and DOI have worked closely to
make the eight terabytes of imagery data available as more than
20 dynamic, multispectral, multitemporal image services. The data
available includes the Landsat Global Land Survey (GLS) datasets,
which provide the best worldwide imagery data for measuring
global change. With these services, users have dynamic access to
all the spectral and temporal information in this massive imagery
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archive. With access to this data as online image services, users
benefit from significantly reduced imagery storage and management requirements.
As Esri announced last year, this imagery is furnished as standard services available from ArcGIS Online. Users will be able to
build web maps using this information and share their analyses
for better understanding and collaboration. Esri also provides
web maps on ArcGIS Online that show how these new services
can be used and explains the measurement of change over time
and space using the Landsat data. Because these services are also
multitemporal, they can be used for performing change analysis that can span 30 years in ArcGIS Desktop or ArcGIS Online
applications.
The dynamic image services result from on-the-fly processing of
the original Landsat scenes by ArcGIS Server Image extension so

Focus

all data contained in this imagery is immediately available for use in
maps and analyses. Processing for source images can be specified
for an area of interest. The services are available in different standard band combinations that include
• False-color (bands 4,3,2), which is useful for vegetation studies
and crop growth monitoring
• Natural color with atmospheric penetration (bands 7,4,2), which
is best suited for analysis of urban study areas
• Vegetation analysis (bands 5,4,3), which provides the most information for agriculture and forest management applications
In addition, Esri created an easy-to-use web-based Landsat
viewer for visualizing, analyzing, and detecting change using these
image services. Built with ArcGIS API for Flex, the application
interface gives on-click access to a variety of information products. Users can quickly zoom and pan to anywhere in the world.

Landsat 7 World Mosaic 12/31/2000
Sensor: L7 ETM+
Landsat imagery courtesy of NASA Goddard
Space Flight Center and US Geological Survey

Information screens introduce the data furnished through the
application.
The Landsat viewer contains fast, easy-to-use change detection
tools that enable users to conduct multitemporal image analysis of
change through image differencing. The Landsat viewer automatically calculates this information based on user selections and displays the resultant information on a change detection map where
users can further interact with the data.

esri.com Spring 2011 au

17

Integration
Project Saves
a Million
Utility makes business information
accessible through single seamless path
By Toni Jackson, GISP, San Antonio Water Systems

Features

N

o matter how talented the landscaper,
without consistent care and rich soil,
a garden will not flourish. The same is true
for corporate data repositories, which must
be planned, built, and maintained with
care. Isolated databases typically don’t provide data-rich business intelligence. It’s an
analogy that utility company San Antonio
Water Systems (SAWS) of San Antonio,
Texas, understands well.
SAWS provides water to the seventhlargest city in the United States and was
adept at cultivating and maintaining a
significant network infrastructure that
ensured clean water and efficient sewer services for its customers. It also accumulated
many data layers specific to SAWS network
assets and service locations that supplied
business intelligence.
However, SAWS had not developed harmonious, integrated information systems.
More important, geography had been
overlooked. With no seamless connection
among mission-critical data plots and
no unified spatial asset references, SAWS
was nurturing “a subpar bed of overgrown
weeds,” making it difficult to maintain its
high level of service and plan for business
growth, according to SAWS GIS manager
Cindy Tuttle.
“Our information management systems
involved a real patchwork of paper maps,
electronic tables, CAD files, mainframe
tables, and various other disparate databases,” said Tuttle. “All of those isolated pockets
of information created a perfect breeding
ground for data duplication and inaccuracies and made sharing geographic data
and updating it really difficult. Moreover,
without an accurate spatial view of our
assets and customers, it made it hard to
analyze our business, adequately respond
to clients, and proactively plan for business
development.”
Recognizing the need for a better solution to manage and share important business data, SAWS launched an initiative to
create an enterprise-wide GIS and an asset
management system. This combination
would provide an integrated and automated
environment to easily update and maintain
accurate map, network, operations, and account data across the entire organization.
However, Tuttle realized that to be successful, this ambitious project would need to
begin by cleaning SAWS data.

So, SAWS GIS professionals began meticulously digging through disparate databases, weeding out data inaccuracies and
duplications, seeding data gaps, pruning
existing data layers, and integrating and
harmonizing dataflows in an effort to clean,
purge, and integrate critical business data.
Two years later, Tuttle and her small
staff have triumphed over significant data
conversion challenges, enabling them to
fulfill SAWS’ vision of producing business
information that is accessible through one
seamless path. The web-enabled GIS not
only provides a seamless view of SAWS’
service area—its networks, assets, service
points, and taps—but also provides the core
datasets for the asset management system.
It allows personnel to better assemble and
schedule work assignments, monitor the
pipeline network, perform quality and asbuilt inspections, correct discrepancies in
the customer billing system, and analyze
its customer base to identify new business
opportunities—and business is blooming
because of it.

Serving One Million Customers
Though the history of providing water and
wastewater services in the San Antonio,
Texas, region dates back to the late 1800s,
SAWS was born as a single water utility in
1992. Created through a consolidation of
three previously separate utility providers,
SAWS today provides water and wastewater services to about one million customers and maintains more than 9,000 miles
of water and sewer mains buried below its
560-square-mile service area.
True to its conservation mantra, SAWS
built and manages the nation’s largest recycled water delivery system. The system
distributes approximately 29 million gallons of recycled water per day that flows
through more than 100 miles of pipeline to
golf courses, parks, and commercial and
industrial customers throughout the city.
In September 2010, SAWS achieved the
biowaste-recycling trifecta at its Dos Rios
Water Recycling Center. The first plant of
its kind in the country, the facility recycles
wastewater and waste solids and converts
the methane off-gas into natural gas to sell
on the open market.
As SAWS operations have expanded and
diversified, it has continually accumulated
corporate information that records and
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monitors the company’s daily operations.
However, efforts to create, maintain, and
connect that data have not been as aggressively pursued as SAWS’ service expansions.
Without a direct and stable hub to internally
connect the company’s external service
points, SAWS was inadvertently washing
business opportunities down the drain.
“Carrying out routine, simple business
tasks would often send staff on laborious, long hunts—either physically or electronically—to find all the information they
needed,” said Tuttle. “Then, when they did
find data, it often wasn’t complete or accurate, particularly asset attributes and
location data such as addresses, which are
critical to our service.” Core datasets, such
as assets and customer accounts, were held
in different databases that lacked any geographic representation. “That was impacting our ability to comprehensively analyze
our networks, service connections, and
customers to identify savings or revenue opportunities,” said Tuttle.

and maintained in isolation, with a singleminded purpose for each department,” said
Tuttle. “So significant challenges arose
when we tried to integrate data from different formats, schemas, and databases
to serve a unified information management system. These general incompatibility issues then became magnified when we
needed to map all that data to bring a precise visual element to every tabular list and
numerical value.”
However, even more problematic than
rectifying missing attributes, inconsistent
schemas, or incomplete datasets was the
inaccuracy, and often complete absence, of
precise spatial representations of customers’
addresses. “Addresses have been recorded
and stored in myriad ways throughout
SAWS, the majority of which have been in
tabular form with no tied geography,” said
Larry Phillips, a planner with SAWS. “The
problem with that is accurate location data
is fundamental to GIS—it is the basis for
which all other elements are referenced. So

Trolling the web, Phillips discovered Esri’s
ArcGIS Data Interoperability extension.
This tool uses Safe Software’s FME spatial ETL (extract, transform, load) technology that enables users to convert, integrate,
transform, and distribute data in more
than 100 geospatial formats. It provides
more than 200 transformers to help automate functions and perform quality control
checks across different data sources. In
short, it seemed to be the “do more with less”
tool they needed.

In three days, the tool corrected and moved
211,000 sewer lateral points, saving the two
GIS professionals eight months’ work.
In 2005, SAWS launched an initiative to
correct this data disconnect. A centralized
Hansen asset management system and an
enterprise-wide ArcGIS platform would
provide personnel with a unified, detailed,
and spatial view of the organization’s most
critical business information and automate routine tasks such as generating work
orders. Though the move would provide data
intelligence to enhance SAWS business operations and services, building the system
would only be possible by resolving significant data conversion challenges.

Integration Challenges
It didn’t take long for the small GIS team to
identify notable data interoperability challenges. Of particular concern were how best
to validate, harmonize, and geographically
visualize the account data held in mainframe tables, billing data maintained in separate mainframe tables, operations tabular
data in another database, and hundreds of
MicroStation-based water/sewer map layers
stored in another database.
“All of our datasets had been created
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it was clear that the data conversion process had to start at the root of all other data
layers and functionality—the address.”
An intense, daily effort began to untangle
and weed through hundreds of MicroStation
map and attribute layers and account tables
to tie asset locations, asset attributions, and
customer service points to their correct addresses—all 500,000 of them—one point at a
time.
Every tabular address field had to be
converted into a geographic location on a
map. “Address points had to be on the correct parcel where they belong, and service
points had to match the actual service location of their meter or sewer connection,” said
Phillips. “We had to validate and correct
every one of those points, and we were doing
this manually, one by one, for half a million
points.”
After two years of this laborious process,
it became clear that the GIS department
needed to find a more expeditious but not
overly costly way to resolve such data interoperability issues to successfully launch
SAWS’ integrated information system.

 The GIS team converted hundreds of

MicroStation-based water/sewer map layers,
such as this one, into GIS-based, spatially
accurate map files that support the asset
management system.

From Days to Minutes
Thirty days after implementing the extension, Phillips had successfully transformed a
two-day data manipulation task into a fiveminute exercise. SAWS road network layers
are routinely received from a third-party
source, requiring a GIS professional to spend
two days manipulating and correcting the
road features to properly integrate with the
GIS. Using the extension, Phillips created an
automated workflow that transforms, corrects, and integrates each new road file with
one mouse click. The time savings just for the
road tool paid for the first extension license.
For the GIS team, that automation was not
only an “aha” moment. Merging road layers,
the team suddenly saw the potential for it
to become the tool of choice for cleaning up,

Features

 One of the maps created after the team

reviewed hundreds of MicroStation maps,
attribute layers, and account tables to tie
asset locations, attributions, and customer
service points to 500,000 addresses

integrating, manipulating, and distributing
more than three million data features and
supporting a host of automated workflows
and business analysis tools.

Million Dollar Savings
To ensure the central data layers were ready
for operational applications, Phillips applied
the extension to both validate the initial
data cleanup and rectify any discrepancies
as well as create the framework to easily
update and integrate new customer address accounts and service points. Because
MicroStation-based sewer and water features were not directly connected to their
attributes, it was difficult to readily identify
relationships between sewer lateral lines
and sewer connection points or their exact
geographic locations.
Using the extension, Phillips designed
an automated point snapper workflow. The
software automatically snaps a sewer service point to its correct lateral line, along
with all the attribute information relative
to each point and line. In three days, the
tool corrected and moved 211,000 sewer lateral points, saving the two GIS professionals
eight months’ work.
Phillips customized a similar process for
spatially correcting and linking sewer laterals to manholes—a task that he says would
not have even been considered possible
with previous software tools. Previously,
measurement references for distances from
laterals to the downstream manhole were
annotated on each MicroStation drawing in
several numerical formats. Phillips accurately tied each lateral to its relevant manhole

and transformed those annotations into precise and consistent spatial references attributed to each lateral/manhole asset. In two
days, the tool populated the GIS with nearly
171,000 sewer lateral measurements.
Now that the extension has readied the
GIS, the team continues developing new
ways of applying it. For example, Phillips
created three customized quality assurance/quality control workflows to routinely
analyze SAWS’ sewer, water, and address/
service point data layers. Set to run weekly,
the tool checks for data discrepancies and
automatically alerts the GIS team of problem areas. Quality checks are not confined
to the GIS; the tool also analyzes the Hansen
data to ensure both information management systems are in sync.
With once insurmountable data conversion issues solved, the GIS is now ready to
support several Hansen-based operational
applications and functions including an
automated work-order module that enables
personnel to seamlessly integrate service
requests and automatically generate corresponding work orders—functionality that
allows them to execute 11,000 orders a month.
By the end of 2010, the GIS also served the
core data for more automated business tasks
such as permitting and customer service.

Conclusion
The extension “has truly allowed us to be
much more productive in much less time
with far fewer people and with much higherquality results,” said Phillips. “We have significantly reduced labor efforts from days
into hours for a host of routine data tasks.”
In addition to the consistent, integrated, accurate, and dynamic GIS, SAWS now has a
seamless environment to view and analyze
its business.
“We accomplished a massive data conversion project and developed an enterprisewide GIS with an extremely small team and
very little cost,” added Tuttle. Without the
cost-effective Data Interoperability tool, “we
would have needed to double our team to
accomplish what we did with a few people’s
effort. In fact, we estimate the money saved
in our first year alone is nearly one million
dollars. Moreover, the software has freed
our team to initiate projects we otherwise
would have never had the time or resources
to do.”
With more time to dedicate to bettering
the GIS datasets and functionality, SAWS’
data management will continue to grow
organically to support increasing demands
and changes in business directions. That is
an information landscape worth nurturing.

 Using the tool created with the Data Interoperability extension, Larry Phillips, a planner

with SAWS, created an automated workflow that transforms, corrects, and integrates each
new road file in one quick operation. Previously, the same operation required two days.
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Cloud
Th ree-quarters of the state of Queensland, Australia, was declared
a disaster zone as a result of flooding that began in late December
2010. Flooding endangered residents and inundated homes, businesses, and farmland. Agencies responding to the disaster and residents of affected areas needed quick access to current information
on the evolving situation.
Ben Somerville and Nick Miller of ESRI Australia Pty. Ltd. worked
through the night to get the Brisbane City Council (BCC) Flood
Common Operating Picture (COP) application up and running with
the latest, most accurate information. “We were asked to create the
application at 7:30 Tuesday night,” Somerville said. “We went to the
crisis room, gathered the data, and were back at the office an hour
and a half later. Moving the data via FTP to the cloud took the longest—nearly six hours. While that was happening, we created a local
version of the COP app that we could move to the cloud. At 7:00 a.m.
Wednesday, the web mapping application was operational.”
Th is story played out many times during many disasters in
2010—including the Deep Horizon oil spill in the Gulf of Mexico and
earthquakes off the coast of the Maule region of Chile and near Portau-Prince, Haiti. GIS and IT professionals quickly put together a GISbased web mapping application in response to an overwhelming
demand for information about each event. Traffic to these websites
has demonstrated that the public is just as interested in timely, accurate, interactive maps as emergency responders and government
officials.
Initially, the mapping application was configured for internal use
by state government emergency services agences. Said Somerville, “As

soon as the app was published on the BCC website, it quickly went viral.”
The key to the success of these types of apps is cloud GIS, a tightly
integrated system of components and content that can be deployed
off premises within a matter of hours and administered remotely.
During a major emergency, GIS professionals, such as Somerville
and Miller, don’t have the time or resources to pull existing equipment and software oﬄ ine and repurpose them to support a single
web application able to serve tens of thousands of visitors daily.
What they need is access to a clean machine that is configured and
ready to go within a few minutes. They also need massive enterprise
resources that can instantaneously handle spikes in demand but
also automatically scale down as web traffic decreases.
In these recent disasters, the central hub for publishing and disseminating GIS services has been ArcGIS Server on Amazon Elastic
Compute Cloud (EC2). Amazon EC2 is a web service that provides
resizable compute capacity in the cloud. In addition to its use for
emergency operations, many organizations use a combination of onand off-premises deployments of ArcGIS Server. In most cases, the
off-premises (or cloud instances) complement—but do not replace—
the organization’s on-site deployments.
By far the most observable use of cloud GIS is to support highvolume web mapping applications, such as the Brisbane City Council
Flood COP. Apps of this type must automatically and seamlessly
support high traffic demands and also perform well under duress.
Instances can be stopped, started, or terminated as necessary.
Cloud GIS is also often used to off-load massive spatial analyses
and processing so that the local computing infrastructure isn’t

 Three-quarters of the state of Queensland, Australia, was declared a disaster zone as a result of flooding that began in late December 2010.
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Fast, reliable support
for disaster response
By Keith Mann, Esri Writer

impacted. When processing is complete, the
instance can be stopped or terminated and
the resulting data product moved to an onpremises server.
Another primary use of cloud GIS is
developing and testing enterprise applications outside the production environment.
Developers can easily access an enterprise
server, build and deploy services and applications, and share those products with
usability testers and other developers. Once
again, the server instance can be discarded
when it is no longer needed.
There are three main advantages to using
a cloud instance of ArcGIS Server for each of
these purposes.
First, there is no software to install.
Anyone can simply acquire an Amazon
Machine Image (AMI) through Esri. The
AMI comes with ArcGIS Server installed
 In response to catastrophic flooding in Queensland, Australia, ESRI Australia created a
and configured along with ArcGIS Desktop, cloud-based web mapping application for supplying information that meets the needs of
ArcSDE on Microsoft SQL Server Express, responders and the public.
and 100 GB of attached storage.
By deploying ArcGIS Server in a cloud environment, emergency
Second, no additional on-site hardware need be acquired or maintained. Because ArcGIS Server on Amazon EC2 requires no special responders can use as many or as few computing resources as nechardware except a connection to the Internet, GIS or IT personnel essary without committing to a long-term purchase of hardware or
don’t have to worry about impacting on-premises infrastructure other IT infrastructure. More important, they can quickly set up fast,
or requisitioning, receiving, assembling, and supporting additional authoritative web mapping apps—within hours in most cases.
While the initial requests for a mapping app may be coordinated
hardware.
Th ird, enterprise-level services, such as autoscaling and elastic through federal, state, and local government emergency manageload balancing, can be added to the configuration to automatically ment professionals, there appears to be an increasing demand for
spin up new instances of ArcGIS Server during demand spikes high-quality, authoritative web mapping applications by the general
and efficiently distribute capacity across healthy instances. As an public and media. In the future, expect to see more public-facing
event winds down or changes focus (from response to recovery, for web mapping applications powered by cloud GIS used to not only
example), these cloud services can be reconfigured to accommodate support emergency operations but also feed the public’s demand for
trusted information.
the organization’s needs.
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GIS-Based Community
Risk Assessment
Tools for wildfire prediction and mitigation
By Ahmed Abukhater, Esri Global Industry Manager for Community Development

 The analysis trilogy: factors used for the analysis

Wildfi res are one of the most notoriously destructive and devastating natural hazards in
the United States.
Planners and policy makers need tools
that enable them to assign land uses and
identify community assets to avoid wildfi re
hazards in the communities most susceptible to natural and man-made disasters. GIS
can provide these effective planning tools
and insights to prepare for natural and manmade disasters and mitigate their impact.
Both policy makers and the community at
large can plan for pre- and postdisaster response and mitigation efforts.
Numerous wildfi re methodologies primarily focus on predicting where fi re is most
likely to occur based on historic data and
spatial characteristics of the environment.
What’s missing is knowledge of the impact of
wildfi re on vulnerable populations and critical infrastructure. To that end, predicting
fi re hazards by modeling areas that are most
vulnerable to fi re and measuring the impact
on the community’s assets and human and
physical resources is both important and
warranted to mitigate wildfi re hazards and
associated costs and fatalities.

Burnet
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Caldwell

 The study area was Travis County, Texas.
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Analysis Trilogy
Temporal indicators

Potential for Ignition
1. Current & Historical
Climate Data
Precipitation/drought events
Lightning strikes
Wind speed & direction

2. Current & Historical Fire
Occurrences Data

3. Current & Historical
Emergency Calls Data

380 Total Points: 38%

Spatial indicators

Human indicators

Potential for
Combustibility/Propagation

Potential Ramification

1. Exhisting Fuel &
Topographic Data
Fuel types
Slope, Elevations, Aspect

1. Exhisting Data on
Structure/Infrastructure
Population centers
Urban interface
Critical infrastructure
Evacuation potential

2. Fire Suppression
Capability
Initial dispatch locations
Spatial morphology
Emergency response time
Fire containment
Dry hydrants

420 Total Points: 42%

200 Total Points: 20%

Improving emergency response in areas infrastructure assets. In particular, this
Thesesusceptible
are identifiedto
in collaboration
with local community
AFD
most
frequent fi res—based
studyand
conducted
spatial modeling and repon data interpolation and prior delineation resentation of wildfi re hazard analysis and
of these areas—can help save lives and pre- spatiotemporal interpolation of communicious resources. Given the importance of ties at risk; developed a standardized planforest-urban interface fi re prediction and ning support system (PSS) for methodology
mitigation, this article describes how to of GIS-based regional molding of Wildfi re
conduct a community risk assessment from Susceptibility Index (WFSI) for planning
a planning point of view and proposes a GIS- and policy making; identified areas at risk
based multiple-criteria evaluation (MCE) and vulnerable communities; and provided
framework for analyzing, predicting, and ul- better assessment tools and capabilities for
timately mitigating the impact of wildfi res.
future land-use planning and policy making.
The study area was Travis County, Texas.
Assessing Wildfire Impact
With nearly a million residents, the county
Th is article references a study for develop- encompasses the cities of Austin, Jonestown,
ing a systematic methodology for assess- and Round Rock. It includes major populament of wildfi re impact on a community’s tion, business, and educational hubs such as
critical assets, including human capital and the University of Texas at Austin.

Features

 A conceptual model for the Wildfire Susceptibility Index (WFSI) methodology

Geospatial Methods and
Analyses
Fire Propensity
Index
Risk Analysis
Fire Ignition Risk

Lightning strikes
historical occurrences
(long/lat)

Hazard Analysis

Potential Ramification

1. Fire Combustibility
and Propagation

1. Human Capital

Canopy
cover

Fire historical
occurrences
(long/lat)

Stops

Weighing criteria
and overlay

Collaboration/
input from AFD

DEM Terrain
analysis

Major road
network
Rivers and
streams
Major roads
and highways
Water bodies
(water withdrawal)
Major road
network

Emergency calls
historical occurrences
(long/lat)

Current
land use

Wildland Urban
Interface (WUI)
Zones

Proximity to urban
interface
Density

Initial dispatch
locations density
Initial dispatch
locations

2. Critical Infrastructure

Structural damage density

2. Fire Suppression
Capability

Community Risk Analysis
Spatio-temporal
interpolation of
Communities at Risk
(3D Modeling + Time)

Forest
density

Aspect

Collaboration/
input from AFD

Census data

Structural damage and
power outage probability

Elevation/
Ridge line

Ignition risk
propensity

Transportation network

Weight criteria
and overlay

Crown fire
potential

Vegetative
coverage
Vegetation /
surface fuels

Population density

Propensity of
human casualty

Wind speed
& direction

Transportation
Initiated fire risk
Major roads
density

Sensitive Areas Contingency
Valuation Index

Precipitation

Lightning density

Fire density/
probability

Fire Behavior/Spatial
Diffusion Index

Meteorological and
Hydrogeomorphological
Index (MHI)

Ignition Risk
Propensity

Proximity

Th is analysis is composed of three key indicators: temporal, spatial, and human. These
represent the potential for ignition, fi re combustibility, and propagation (or how fast the
fi re spreads) and possible ramifications for
the community. The analysis captures not
only the risk and probability of wildfi res
but also the magnitude of impact on the
community.
The potential for ignition is measured by
the temporal indicators including current
and historical climate data about precipitation, drought events, lightning strikes, wind
speed and direction, current and historical
fi re occurrence data, and current and historical emergency calls data.
The potential for fi re combustibility and
propagation is measured by a set of spatial
indicators including existing fuel and topographic data (such as fuel types, slope, elevation, and aspect) and fi re suppression capability (such as initial dispatch locations and
spatial morphology data about emergency
response time, fi re containment, and dry
hydrants).
The potential ramifications for the community are measured by existing data on
population centers, urban interface, critical
infrastructure, and evacuation potential.
A community survey was conducted, and
several meetings with the local community
were held to collaboratively determine the
importance of each of these indicators in the
analysis. The relative importance for these
factors was represented by the weights assigned to them.
Th is analysis trilogy translates into a

Wildfire Susceptibility Index (WFSI)

Emergency
response time

Parks

Facilities

Historical
landmarks

Schools

Urbanized
areas

Hospitals
Proximity

Fire
containment

Dry
hydrants

3. Evacuation Potential

Density
Proximity

Bridges
Road access
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Risk
Statement

Contributing
Factors

Derivative
Data

Trigger
Event

Valuation
Methodology

Response
Strategy

Elevation

DEM

Fire
propagation

Very low (1): 93-170m
Low (2): 170-230m
Moderate (3): 230-290m
High (4): 290-350m
Very high (5): 350-483m

- Very low
- Fire containment: creating natural
and artificial fire breaks (such as
rivers and highways)
- Dumping water from the sky

Slope

DEM

Fire
irruption

Very low (1): 0-5%
Low (2): 5-15%
Moderate (3): 15-30%
High (4): 30-45%
Very high (5): 45-133%

Aspect
(wind direction)

DEM

Fire
propagation

Very low (1): N, flat
Low (2): NE, NW
Moderate (3): E, W
High (4): SE, SW
Very high (5): S

Fuel

Vegetative
coverage

Fire
irruption

Very low (1):FBPS 97, 98, 99

Road access
and initial
dispatch
locations

Fire
irruption

Firenado
potential

Fire spread
& damage

Response time

 Examples of contributing factors
 GIS layers used for the analysis
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Low (2): FBPS 96
Moderate (3): FBPS 10, 11, 12
High (4): FBPS 6, 7, 8, and 9
Very high (5): FBPS 1, 2, 3, 4, 5

Improving structural fire safety:
- Using fire resistant materials
- Exits clearly marked
- Entrances ate not blocked by
any flammable materials
- Access for a large fire truck
- Reducing vegetation
encroachment around buildings

Very low (1): < 5 min
Low (2): 5-8 min
Moderate (3): 8-10 min
High (4): 10-15 min
Very high (5): > 15 min

Early warning system:
- Local officials issue burn bans
- Issuance of red flag warnings
- Reverse 911 calls for residents
(alerting to evacuate)

conceptual diagram that includes risk analysis, hazard analysis, and potential ramifications to create a fire propensity index, fire
behavior/spatial diffusion index, and sensitive areas contingency valuation index. Each
of these three pillars is inclusive of several
factors and layers.
Wildfire can cause a blazing inferno
with a potential of speed ranging from
30 to 40 miles per hour, which causes the
fire to spread rapidly, creating “firenado”
potential. Weather conditions, surface fuel,
and topography, among other factors, can
contribute to this situation.
For Travis County, Texas, weather conditions were characterized as a severe drought
pattern. The area has experienced drought
for the past 10 years. The area has low precipitation and currently receives only 50 to
60 percent of its normal precipitation.
With regard to surface fuel, Travis County
has high forest density and canopy cover
with crown fire potential. West Austin is
densely covered with trees and brush, highly
flammable because of the severe drought
conditions.
West Austin also has steeply sloping
hills and canyons, and high wind speed
and elevation are also factors. Other factors to consider include high fire ignition
risk related to transportation and historic
wildfire occurrences and the area’s high
population density. The area’s poor egress

Features

is related to the transportation network
and urban morphology. The area also has
low fire suppression capacity owing to the
locations and levels of coverage provided by
nearby fire departments.
Each factor was represented by a separate
layer that was created, extracted, or derived
from other data sources or a combination of
sources. The table on page 26 shows a few
examples of these contributing factors associated with a risk statement, derivative data,
contributing factors, trigger event, valuation
methodology (how these factors are categorized in the analysis), and response strategy.

Process and Decision Workflow (GIS Model Workflow Chart)

Analysis Results
GIS was used to create and extract data
layers to represent each factor listed in the
conceptual diagram and conduct spatial
analysis to derive density, propensity, and
proximity maps. These maps were consolidated and combined into the six category
maps, which were juxtaposed and overlaid
(after assigning weights reflecting the community’s priorities) to produce the final map
representing the WFSI.
The final map shows areas threatened by
extreme and very high potential for wildfire
breakouts in red and orange. Areas in north
Travis County and west Austin are identified as high-risk areas because of the current drought conditions, dense forest and
canopy cover, flammable vegetation, and
steep slopes. In addition, these area have
concentrations of population and critical
infrastructure combined with relative lack
of resources and fire suppression capacity.
Representing this information in a threedimensional diagram helps furnish a better
understanding of the level of risk and magnitude of impact on communities affected by
potential wildfire.

Conclusion
This article describes a methodology for conducting community risk assessment for wildfire hazard on a regional scale and provides
evidence of the value of using GIS in data
management and organization and planning analysis. It is imperative for emergency
respondents on one hand and planners and
policy makers on the other to take advantage
of this type of analysis. GIS helps model areas
that are most vulnerable to wildfire.

 GIS analysis results, the Wildfire Susceptibility Index

Knowing where fire incidence is most
likely will help emergency services respond
in a timely manner to mitigate the impact
of fire. Knowing which populations are at
risk, communities can determine where
to allocate resources most effectively to
save money and human lives. Planners can
also use this analysis to inform future land
use policies and guide decisions regarding
future growth areas. The results can also be
disseminated to inform future land-use suitability analysis and conflict maps to avoid
future expansion in those areas identified as
high-risk areas for wildfire hazard. This spatial knowledge is critical for land-use policy
and decision making.
GIS is an invaluable tool for conducting
this analysis to produce actionable knowledge and intelligence. By integrating data,
geoprocessing tools, ModelBuilder, and
visualization tools, the impact of human
activities on the natural and built environment can be evaluated. State-of-the-art GIS
visualization and analytic tools help officials
understand and analyze the spatial and
temporal characteristics of wildfire.

For More Information
Ahmed Abukhater, PhD, GISP
Esri Global Industry Manager for
Community Development
aabukhater@esri.com
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&GIS
Making GIS content available
in interesting and useful ways
By Keith Mann, Esri Writer

If you own a smartphone, such as an iPhone
or Android, you probably have an app that
uses augmented reality (AR). Th is technology superimposes digital information on
whatever you’re looking at through your
phone’s camera.
These types of AR apps usually combine
an assortment of miniaturized technology
devices—optical sensors, accelerometers,
GPS, gyroscopes, solid state compasses—
along with context-sensitive information,
that is delivered as a web service. The service
content may be displayed as location-based
labels (or billboards) that hover over or in
front of objects you see through the camera
display. The labels usually present additional
information, including photos, but often
provide reviews and contact information
for things like restaurants, Wi-Fi hot spots,
or houses for sale. You might use AR apps
to discover and learn more about objects
around you.
Some AR apps allow you to use your phone
camera to perform sophisticated measurements of distances and angles or even track
cosmological events such as the azimuth of
the sun. Still other AR apps amazingly recognize patterns in photos, diagrams, and
bar codes that then link you to additional
content or services, such as product reviews,
price comparisons, or videos.
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Familiar Applications of AR
While the concepts of AR have been around
for decades, the technology has been applied
to so many different types of media that it
is difficult to point to any one application as
the embodiment of augmented reality. For
example, American football fans are used
to seeing the virtual fi rst down line that appears on the field during televised games—
they expect to see it. Movie directors have
portrayed augmented reality in movies such
as Minority Report (2002) or Avatar (2009)
to show how immersive technology might be
used. Some of the most visually exciting examples of AR entertainment are augmented
projections or projection mapping in which
computer imagery is projected onto physical
objects, such as a building facade, to create
an augmented but realistic-looking new
object that morphs continuously before the
viewer’s eyes.
The military uses a type of AR in the
head-up display (HUD) that appears on the
cockpit window (or view port) of a jet fighter.
These displays make it easier for pilots to
access critical information such as air speed
or angle of attack without having to break
their focus from the reality in front of them.
Similarly, automobile manufacturers are
also experimenting with HUD windshield
displays to improve driver safety.

Seeing GIS Data Using AR
Richie Carmichael of the Esri Applications
Prototype Lab has been experimenting
with using AR to visualize GIS content. He
thinks of AR as simply adding to reality
in a way that enhances or improves upon
what you see displayed in a web or desktop
application.
“GIS data is already a source of spatially enabled information that can be fed directly to
your mobile device,” explained Carmichael.
“Your phone knows where it is, the direction
the camera is facing, and the inclination of
the device in your hand. Th is information,
combined with GIS data, not only adds to the
end user’s experience but also makes GIS accessible in a new and interesting way.”
As AR becomes more prevalent in phone,
tablet, and computer applications, more developers will begin integrating GIS services
and content to serve very real and practical
purposes. Mansour Raad, a senior software
architect at Esri, envisions AR apps that
will channel GIS content to professional
end users using mobile devices to help them
make decisions on-site using the most upto-date and reliable information available.
“Imagine that you could point the camera
on your phone at the ground and see the
location and orientation of water pipes and
electric cables buried under the ground because your AR app is cross-referencing the
GIS system with your location and giving

 Richie Carmichael of the Esri Prototype

Lab built this AR/GIS app using ArcGIS
API for Silverlight and the open source
Silverlight Augmented Reality Toolkit. It
orders and offsets overlapping imagery.
Imagery is tagged with sensor information
such as capture date, percentage cloud
cover, and satellite position.

Developer’s Corner
you a kind of x-ray vision so that you can visualize the infrastructure that is underneath
you,” explained Raad.
“Not only would you be able to see hidden
objects, you’d have access to their attributes, you’d be able to pull up engineering
diagrams, and even tap into real-time sensor
networks to view water pressure or amperage.” Raad suggested that you might use
your phone’s camera to take a photo of the
augmented display and e-mail it to your
project team or sync it with the GIS-enabled
work order system so that it can be accessed
by the project manager and the work crew.
“What makes the combination of AR and GIS
really exciting is not just the visualization of
GIS content, which is very cool, but the integration of that content with the rest of the
enterprise. That’s what GIS is all about.”

Getting Started with AR
Development
AR app development is surprisingly straightforward. AR service providers, such as juniao
or Layar, provide both an AR browser and
the development resources needed to simplify deployment for iPhone and Android.
To use the junaio app, you start by registering a “channel” with junaio. The channel
provides a callback to your server, where the
processing takes place. For example, if you
use the app to find geographic information
near your current position, junaio brokers
the calls to your server, which processes
the request, then passes that information
back to your device. For a GIS developer,
this means accessing the REST endpoints of
ArcGIS Server services as the link to dynamic GIS content and tools or preprocessed
geographic information such as 3D terrains,
videos, or map layer stacks.
“Augmented reality can be difficult to
explain to people,” said Thomas Emge, also
from the Esri Prototype Lab. “It’s often easier
to show someone an AR application first, let
them experience it, and then start the conversation about what you want to do with it.
At first, there’s the cool factor that’s fun to
do and easily impresses most people. Next,
you have to start thinking about design and
usability.”
Emge suggests that developers begin by
considering the end user’s experience. “There
are different ways to apply AR to your app,”
said Emge. “In one case, you are overlaying additional information in your camera’s

viewfinder. Here the device’s location and orientation play an important role. In a different
case, the information seen by the camera is
sent to a server and processed, then sent back
to you. Here, pattern recognition technology
is being employed, and the response can be
as simple as playing a video or as complex as
showing the results of spatial analysis.”
Raad sees great potential for using the
pattern recognition capability of AR. “The
image can be anything—a photo, a map, a
barcode, or even the stars in the sky. Using
the camera, the AR app recognizes the pattern and does something that augments or
mixes additional content with what you’re
seeing.”
For example, Raad has created a sample
app that uses pattern recognition to let users
point an iPhone camera at a photo of a map,
which triggers the loading of a video that
shows a rotating globe displaying the same
information. Raad used ArcGIS to compose
the 2D map data and drape it on a globe.
Then he animated the globe and created the
video, which is hosted on a server. Next, he
registered a channel with junaio that links
his video with the junaio AR application.
Anyone with an iPhone can download the
junaio app, search for the channel, point the
iPhone camera at a photo of the map, and
view the rotating globe.
Carmichael also used pattern recognition. He linked a photo on a piece of paper
to a related image of a map layer stack in his
desktop application. However, in this case,
the layer stack appears to dynamically hover
above the photo—even if the photo is moved
around.
Any developers using an AR toolkit and
one of the ArcGIS APIs for Silverlight, Flex,
or JavaScript can start building their own
AR-GIS apps. The original ARToolkit was developed by Hirokazu Kato of Nara Institute
of Science and Technology in 1999 and was
released by the University of Washington
Human Interface Technology Lab (HITLab).
Since 1999, numerous ARToolkit spinoffs
have been created. In 2010, René Schulte
ported the ARToolkit to Microsoft’s
Silverlight platform, which was released as
the SLARToolkit.
Emge cautions developers to recognize the
limitations of mobile devices. “You may find
that the limited accuracy of the GPS won’t
allow you to place labels and billboards as
precisely as you’d like or that AR calculated

measurements are only approximations,” he
said. “This may frustrate end users with GIS
and CAD experience because they expect a
high degree of accuracy and precision.” Both
Emge and Carmichael recommend that AR
apps be used to query trusted GIS services
for precise measurements and reliable attribute information instead of relying on a
phone’s capabilities.
Regardless of the popularity of AR or the
current limitations of some mobile devices,
AR and GIS would seem to be a perfect
match, not only for consumers but for professionals who rely on geographic information to make real-time decisions.

 Thomas Emge and Sathya Prasad, of the

Esri Applications Prototype Lab, created
the AR app with ArcPhoto tools and Layar’s
iPhone app. It georeferences images
from a geodatabase and displays them as
billboarded entities.

Learn More
Raad maintains a very active personal blog at
thunderheadxpler.blogspot.com. Carmichael
and Emge are regular contributors to the
Applications Prototype Lab blog at blog.esri.
com/Dev/blogs/apl/default.aspx. Both blogs
contain posts on AR topics.

Sources for AR information
junaio: www.junaio.com
Layar: www.layar.com
HITLab: www.hitl.washington.edu/artoolkit
Wikipedia: en.wikipedia.org/wiki/
Augmented_reality
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Converting existing projects
to ArcGIS Add-ins
By Craig Gallant, LJB Inc.

What happened to VBA?

 The finished application

What You Will Need
• ArcGIS Desktop 10 (ArcView, ArcEditor, or ArcInfo license)
• Sample dataset downloaded from ArcUser website
• Microsoft Visual Studio 2008 Express Editions with SP1
(either Visual Basic or C#; free download from Microsoft)
• ArcObjects Software Development Kit (SDK) for
Microsoft .NET Framework (included with ArcMap 10)
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You might ask this after installing ArcGIS 10. With the release of
ArcMap 10, Visual Basic for Applications (VBA) is on the way out. As
the online help article “Migrating VBA customizations to ArcGIS 10”
explains, “VBA no longer provides the best toolset for customizing
ArcGIS and is not included in the default installation.”
At ArcGIS 10, there are two new ways to customize in ArcGIS 10:
Python and the new ArcGIS Desktop Add-in. [Add-ins are a new way
to customize and extend ArcGIS 10. They are authored in .NET or Java
and Extensible Markup Language (XML). They provide a declaratively
based framework for creating a collection of customizations that can be
conveniently packaged in a single compressed file that is easily shared.
Add-ins do not require installation programs or Component Object
Model (COM) registration.] Both options have advantages and disadvantages. You need to pick the option that best suits your application.
Th is article shows how, with a little refactoring, existing VBA code
can quickly be converted to an ArcGIS Desktop Add-in.

Developer’s Corner

 Figure 1: First wizard screen encountered when creating an add-in

This Exercise
The VBA sample for this exercise is a simple form that reads the selected county on the map and displays its information on the form.
You will need at least Visual Studio Express 2008 SP1 (which is a free
download from Microsoft). You will also need the ArcObjects SDK for
the .NET Framework that is included with ArcMap 10. The SDK will
install templates in the Visual Studio environment that will create
the Desktop Add-in project. If the ArcGIS templates do not show up
when creating a new project, make sure you have .NET Framework 3.5.
Because this article is intended to demonstrate the ease of converting VBA code to .NET, some of the description of the project
creation process is not detailed. For more detailed information, Esri
has created a very good example. Search the online help for the article “Walkthrough: Migrating VB6 to VB .NET for ArcGIS 10.”

Types. For this example, all that is needed is a button, so check the
Button checkbox, fill in the fields, and click the Finish button. This
will create the Add-in project and the Button tool (Figure 2).
3. From Project Menu, pick Add Windows Form and name it Form1.
Give the form a width of 319 px and a height of 223 px. Also, change
the form text property to County Info and set the topmost property to True. Th is will keep the form in front of ArcMap. (If you
don’t set this property, every time you click the map, the form will
go behind it.)
4. To make the form look like a VBA form (Figure 3), add some controls to it. With Visual Studio and .NET, all the controls available
in Visual Studio can be used on the form—not just the 14 available
in the VBA editor. Put four labels on the form and set their text
properties to County Name, State Name, Area, and Population.
Because these labels will not interact with the code, leave the default names for these controls (e.g., Label1, Label2).
VBA Form

Visual Studio Form

 Figure 3: Side-by-side view of VBA form and .NET form

5. Add four more labels to the form that will be used to dis-

play the values from the selected county. Name the fi rst one
lblCountyName, the second lblStateName, the third
lblArea, and the fourth lblPopulation . Set the text property

of each one to the word NULL and the autosize property to True.
6. Add two buttons to the form. Call one btnRead and set its text
property to Read Data. Call the other one btnClose and set its

text property to Close. That’s it for designing the form.
When converting a VBA to an ArcGIS Desktop Add-in, creating
the form will take the most time because there is no easy way to copy.
It must be manually re-created. However, as demonstrated in the
next section, the code is reusable and easily upgraded.

Reusing the Code
The VBA sample is a simple program that has four parts:
•
•
•
•
 Figure 2: Second wizard screen for creating command button

Re-creating the Form
1. Start by creating a new project. Choose Visual Basic > ArcGIS

> Desktop Add-ins and choose ArcMap Add-in. Name it
CountyInfoAddIn and click OK.
2. The Add-ins Wizard will pop up. Fill out all the information on the
welcome screen—this will be the information that is seen when
adding the add-in to ArcMap (Figure 1). Click Next to bring up Add-in

A button on a toolbar to show the form
A button to read the selected item
Some labels to display the data
A button to close the form

There is one other major piece: a subroutine called ReadData. Th is
is where the work is done in the VBA sample, and this code needs to
be copied and converted. An easy way to do this is to export the form
to be upgraded out of the VBA editor and open the exported fi le with
the .frm extension in Notepad. Copy the subroutine and paste it into
the newly created form in the add-in project.
In this example, open the included fi le called Form1.frm in
Notepad and copy the subroutine ReadData. Right-click the form
created in Visual Studio and pick View Code. Paste the subroutine in
the code behind.
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Fixing Errors
When the code is pasted, several errors will show up. Most of these
will go away once the right references are added. Because the project
was created in Visual Studio and not the VBA editor, you have to add
references to ArcObjects.

At the very top of the code for the form, above the public class, add
three import statements (Figure 4). Type
Imports Esri.ArcGIS.ArcMapUI
Imports Esri.ArcGIS.Carto
Imports Esri.ArcGIS.Geodatabase

Once the imports and references have been added, the number of
errors decreases from 10 to 5.

Resetting Properties

 Figure 4: Code view with errors and import statements

Th is example requires two references. From Project Menu, pick
Add Reference and choose Esri.ArcGIS.Carto and Esri.ArcGIS.
Geodatabase from the .NET tab. Just adding the references won’t fi x
the problems because the code that was copied worked in VBA because the VBA editor understood the shorter names for ArcObjects.
Th is is easily fi xed by adding import statements at the top of the
code. Doing this lets Visual Studio use the shorter names also.
VBA Code

 Figure 5: Side-by-side view of VBA code and .NET code
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The next fi x addresses something that happens a lot when converting code from VBA to .NET. To set the text to the labels in VBA, the
property is called Caption. In .NET, to set the text to the label, the
property is called Text. Th is is easy enough to fi x.
One way would be to simply replace the word caption with the word
text. Another way demonstrates one of the benefits of using the Visual
Studio environment. Go to the error lblCountyName.Caption
and delete .Caption . Place the cursor at the end of the word
lblCountyName and press the period key. Th is brings up IntelliSense and shows all the properties available to set on the label. Scroll
down and pick the word Text.
While it might have been easier to just retype Caption to Text, if
the correct property is not known, this is a very useful feature. After
changing the labels from caption to text, only one error remains.
Th is is really the only major error in converting the code.

Resetting the Current Document
An error is triggered by Th isDocument. Although the VBA editor
had a reference to Th isDocument, Visual Studio does not know
what Th isDocument is. To fi x this error, change ThisDocument to
My.ArcMap.Document, which is the ArcGIS Desktop Add-in reference to the current ArcMap document.
Visual Studio Code

Developer’s Corner
That’s it for converting the code. Now go to the Build menu and
build the project. After the project is built, the fi les are bundled as an
add-in and automatically installed in ArcMap.

Running the Add-in

 Figure 6: The Add-In Manager dialog box

When all errors are fi xed, Visual Studio displays the warning error
“‘pFCursor’ is passed before it is assigned.” To fi x this, go to the line of
code
Dim pFCursor as IfeatureCursor

To the end of this line, add
= Nothing

From the Window menu, pick Form1.vb [Design]. Th is will switch
back to the Form Design view.
1. Select the Read Data button and double-click it. Th is will add the
click event handler for the button.
2. Open the fi le Form1.frm (if it is not already open) and copy the command Call ReadData(“Button”)” from the btnRead _ Click
subroutine. Paste it into the btnRead _ Click subroutine just
created.
3. Switch to the Form Design view again and double-click the Close
button. Th is adds the close button click event handler. In VBA, all
that was in this event was the command End, which will not work
in the add-in. To accomplish the same task in the new code, just
type Me.Close() in the btnClose subroutine.
All the code has been converted for the form. Figure 5 shows the
code before and after. Not much has changed in the conversion between VBA and the add-in. However, note that when pasting the
code, Visual Studio did convert some code automatically. In this
example, it removed the word Set and it put parentheses around the
command pFLayer.SelectionSet.Search .

Open the USA.mxd sample included with the developer kit. It contains counties and states for the entire United States. Go to the
Customize menu and pick Add-In Manager (Figure 6), verify the
add-in loaded, and close the dialog box. Go to the Customize menu
and pick Customize Mode.
In the Customize dialog box, click the Commands tab (Figure 7).
Choose Add-In Controls from Categories (the category that was
defined when creating the add-in). Drag the My Form Button from
Commands and drop it on any toolbar. Close the Customize dialog
box.
In ArcMap, select a county on the map. Click the button to show
the county form that was just dragged to the toolbar. Th is opens the
County Info dialog box. With a county selected, click the Read Data
button on the dialog box. Th is will read the selected county information and display it on the form. Click the Close button to close the
County Info dialog box.
Th is code could be improved. The add-in model has many more
options. For more information on these topics, see the online help for
ArcObjects for .NET. The Esri online help is very useful.
In conclusion, even though VBA is gone, with a little refactoring
and a good bit of copying and pasting, existing VBA code can be
reused in the new .NET environment.

One More Thing
There is one last thing to do before the code is ready to use. To show
the VBA form, it had to be assigned to a button UIControl from the
Customize menu. When the add-in project was created, the Button
checkbox was checked. Th is added a command button to the project.
From the Solution Explorer, right-click FormButton.vb and pick
View Code. Th is opens the code for the button. In the OnClick()
event, add the following two lines:
Dim frm As New Form1
frm.Show()

 Figure 7: The Customize dialog box

About the Author
Craig Gallant is a senior designer at LJB Inc. in Dayton, Ohio.
He can be contacted at cgallant@ljbinc.com.

This tells the button when it is clicked to create a new form and show it.
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City Benefits Greatly from ELA
Cutting costs, capturing revenue, and improving processes
By Emily Norton, City of Woodstock, Georgia, and Timothy Poe, Barstow County, Georgia
Since the City of Woodstock, Georgia, purchased an Esri Small Municipal and County
Government enterprise license agreement
(ELA), the city’s GIS division and other departments have been able to accomplish
more tasks with less resources while improving the overall quality of the city’s spatial data.
At the beginning of the 2008–2009 fiscal
year, the city of approximately 23,000
purchased an ELA that allows small jurisdictions to pay an annual fixed price in

exchange for unlimited amounts of ArcGIS
software throughout the organization as
well as maintenance, services, and training.
The program overcomes financial and administrative barriers so local governments
can quickly achieve an enterprise-wide GIS
that improves government operations and
service to citizens.
Woodstock’s ELA has been critical in two
projects that improved the accuracy of the
city’s storm water utility billing process and
updated the mapping of the storm water

 The storm water billing process project identified 348 parcels that were not being

assessed city property taxes. Imagery from 2008 and 2009 show new construction in this
rapidly growing area of Georgia.
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and sanitary sewer systems. Rather than
employ consultants to complete the work,
Woodstock decided to take advantage of
its newly purchased ELA and the GIS division’s close relationship with Kennesaw
State University’s geographic information
science degree program. The city hired five
highly motivated and skilled interns from
Kennesaw State University and Gainesville
State College to complete the projects.
In the first project, interns reviewed the
storm water billing process and corrected
errors in impervious surface measurements
and parcel classification. During this process, they found 348 parcels in the city that
were not being assessed city property taxes.
As a result, the team discovered more than
$700,000 in missed tax revenue for fiscal
year 2008 and approximately $1 million in
additional annual revenue for subsequent
years. The entire project was accomplished
in less than three months at a total cost of
less than $25,000.
In the second project, interns updated the
storm water and sanitary sewer systems infrastructure. ArcGIS Desktop was deployed
on an Xplore tablet coupled with Leica’s
MobileMatriX and GPS gear so intern teams
could collect survey-quality data for the
future development of a flow network model.
Overall, both the utility billing project
and infrastructure project were highly successful. Both projects represented not only
a cost savings but, in the case of the utility
billing project, revenue generation for the
city. The projects also provided excellent
educational experience for the interns.
The ELA has also enabled the city to cut
costs significantly by deploying ArcGIS
Server software-based web mapping applications to internal customers. For example,
when a police crime mapping application
malfunctioned, the GIS division deployed
a fully functional web editing application
within five hours. Over the next week, the
police crime analyst made several requests
that the GIS division implemented that enhanced the police department’s mapping capabilities. The ability to edit versioned data
through web applications has met the data

Manager's Corner

integrity and security needs of the GIS division as well as the practical usability needs
of the police department’s crime analyst.
Also, zone commanders and other police
management have ongoing access to up-todate crime maps.
Similar web mapping applications have
been deployed to further enhance public
safety and deliver additional cost savings to
city departments. For instance, the GIS division has developed a web mapping application that aids the fi re department in tracking hydrant locations and maintenance
records so the department can maintain
its excellent Insurance Services Office (ISO)
Public Protection Classification (PPC) rating.
Th is results in cheaper insurance rates for
Woodstock’s residents and business owners.
In addition, a multidepartment task force
has been able to remotely edit and track
vacant buildings to aid in city planning, development, fi refighting, policing, and code
enforcement. The ability to remotely edit a
single versioned data source has eliminated
the extensive data duplication and associated systemic bottlenecks to data acquisition and distribution common under the old
paper-based systems.
The ELA has helped the City of Woodstock
produce and maintain high-quality data
while minimizing both labor and capital
costs. The ELA helped the GIS division
improve work processes and lower overhead
costs. The web mapping capabilities it
supports have significantly increased
data access and usability and simplified
processes for nearly every department
in the city. For more information, visit
esri.com/ela or contact Emily Norton at
enorton@woodstockga.gov.

Flexible Deployment and
Fixed Payments
ELAs offer real value for many types of organizations
Enterprise license agreements (ELAs) can help all types of organizations quickly and
easily implement a GIS platform that includes desktop, server, web services, and data.
In the US, Esri offers ELAs for commercial firms and federal, state, regional, and local
government agencies and low-cost ELAs for smaller local governments and utilities. With
an ELA contract, an organization makes annual payments to Esri for a three-year period
in exchange for a package of software, maintenance, services, and training. ELAs permit
deployment of unlimited quantities of selected Esri products over the term of the agreement. ELAs provide flexible deployment of software, fixed annual payments, centralized
management and support, and access to the most current versions of Esri software.
Esri offers ELAs designed to fit many requirements and infrastructures of different
customers. To learn more about the specific software available for each industry, visit
esri.com/ela or contact ela_info@esri.com.
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Services Meet
Management and
Analysis Needs
Furnishing raster data for
projects large and small
By Michael D. Sweet and John Lucotch, University of Montana

 Example workflow of raw data files to mosaic dataset to

service without replicating the disk storage of the raw files

T

he University of Montana supplies
raster services for a variety of projects
on platforms ranging from desktop computers to web browsers and mobile devices.
Users access the university’s raster data
from locations across Montana and as far
away as Alaska; British Columbia, Canada;
and Kamchatka in the Russian Federation.
As part of a growing need for geospatial products, it has become critical to
serve raster data in a timely and accurate
manner. However, interacting with raster
sources that vary in format, bands, data
type, resolution, and extent can be challenging. In delivering raster products,
it is also important to access raw raster
values, not just a scaled-down representation or image of the data. By adopting
ArcGIS Server 10 with the Image extension, the university was able to meet these
challenges. The ArcGIS Server 10 Image
extension not only serves raster data to
end users with ArcGIS capabilities but can
also serve raster data in Open Geospatial
Consortium, Inc., Web Mapping Service
(WMS) or Web Coverage Service (WCS) formats to other user communities without
duplicating the source or the service.
The ability to serve large raster datasets
in a virtual environment using the mosaic
dataset framework is one of the most important aspects of the ArcGIS Server 10
Image extension. The University of Montana
has taken full advantage of the capabilities
of this extension. It adopted this virtual
platform because it offered scalability and
ease of maintenance. When developing
imagery services on this virtual platform,
it was easy to transition from the development to the production stage and meet the
raster data needs of projects not only on the
local campus but also forest management
projects and projects carried out on a subglobal scale.
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Assisting Salmon Conservation
The Riverscape Analysis Project (RAP) provides a comprehensive
geospatial database to document, assess, and compare the physical
complexity of large salmon rivers across the North Pacific Rim. The
two main components of this hydrological GIS analysis are satellite
multispectral imagery and digital elevation models. The data includes seamless mosaics of Landsat Thematic Mapper (TM) imagery
and Shuttle Radar Topography Mission (SRTM)-based digital elevation data that cover the entire domain and DigitalGlobe’s nested
finer-scale QuickBird multispectral satellite imagery of regional
floodplain observatory sites distributed throughout the region.
The RAP system includes a North Pacific Rim domain that encompasses major North Pacific watersheds of the western United
States and Alaska; British Columbia and Yukon, Canada; and the
Kamchatka Peninsula in the Russian Federation.

The RAP system uses a web-based GIS decision support system
(DSS) based on the ArcGIS Server 10 framework to serve this extensive geospatial database to a broad user community. The DSS
provides end users with a system for conducting real-time analyses
and comparing watershed, riverine, and landscape features across
the North Pacific Rim that is designed to assist in wild salmon
conservation.
RAP DSS can create interactive ranking maps of freshwater physical habitats and salmon production potential. These ranking maps,
based on a set of physical metrics derived from the satellite imagery,
digital terrain, and other ancillary geospatial data, describe watershed, floodplain, inland water body, and river channel complexity.
RAP DSS also provides tools that allow dynamic database queries
and retrieval of geospatial, raster, and tabular data from the RAP database through ArcGIS Server geoprocessing tools utilizing ArcGIS
Server Image extension basemaps. It also provides imagery viewers
using ArcGIS Viewer for Flex applications that display Landsat basemaps, floodplain QuickBird scenes, airborne imagery, and QuickBird
time series.

Interactive DSS Tool

 Inventory map for the State of Montana Arboretum on the

University of Montana campus integrating a high-resolution image
service with a campus basemap service

The project objectives require seamlessly serving imagery and
raster data for this vast geographic area to both internal and external clients. Th is data also must be served at two scales: the North
Pacific Rim scale (Landsat TM and SRTM DEM data) and the floodplain scale (QuickBird data). The ArcGIS Server Image extension and
the integration of the mosaic dataset let RAP view and analyze these
image services. Specific examples include providing imagery and
raster data for basemaps, watershed and floodplain data analysis,
and time series analysis.

The Subwatershed Delineation Tool is one of the main interactive
features of the RAP DSS. Th is Python-based ArcGIS Server geoprocessing tool allows end users to dynamically delineate subwatersheds anywhere in the North Pacific Rim domain. The use of serverside geoprocessing allows simultaneous user inputs through a web
browser interface that takes advantage of a multicore virtual server
architecture.
Th is tool requires an image basemap so the user can accurately
pinpoint the mouth of a given subwatershed. A Landsat TM nearinfrared band image mosaic basemap served through the ArcGIS
Server fulfi lls this need. Th is tool allows individuals to interact with
the RAP DSS from a remote device in the field where there may be
limited Internet connectivity and effectively access the RAP hydrological database, conduct fine-scale analyses, and inform on-thespot data collection or management decisions.
The RAP system includes a diverse user group drawn from national and state agencies, universities, foreign institutions, researcher
organizations, and corporations that have found the imagery services of the RAP helpful in identifying habitats, channel morphology, channel complexity, and land-cover change. RAP DSS, with its
underlying geospatial data and the ArcGIS software framework, is
flexible, modular, and designed to evolve as new data is acquired and
user needs change.

Delivering Framework Layers
Montana Spatial Data Infrastructure (MSDI) efforts are directed at
advancing 13 statewide framework layers. The federal government,
in cooperation with other government and private sectors, has identified 7 geospatial framework data layers for the nation. In addition
to these, the State of Montana designated 6 other layers.
Two of these framework layers, elevation and orthoimagery, are
raster dataset products. ArcGIS Server 10 with the Image extension
is the preferred mechanism for delivering this content to users. The
University of Montana, which distributes and utilizes elevation
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and imagery products, often prototypes deployment strategies in advance of enterprise
deployments throughout Montana.
These services are built from traditional
sources, such as the National Elevation
Dataset (NED) raster dataset and National
Agriculture Imagery Program (NAIP) imagery. However, the University of Montana
also utilizes many other raster data sources.
Montana strives to develop the best framework product and make that product easy to
obtain. The University of Montana often collaborates with other entities in the state on
strategies for optimizing the utilization of
software products like the ArcGIS Server 10
Image extension. Th is collaboration often
extends to neighboring organizations such
as Inside Idaho, Idaho’s geospatial data
clearinghouse, which also employs ArcGIS
Server for delivering services.
Statewide or regional raster dataset products typically require extensive storage capacity. The university utilizes the services
architecture of ArcGIS Server to minimize
data duplication while still meeting the analytic and display needs of users. From a storage management perspective, the ArcGIS
10 environment offers the ability to move
effortlessly from raw raster fi les to a mosaic
dataset to an image service with no duplication of fi les. It requires little overhead to
deliver seamless statewide raster products.
Using the mosaic dataset, generalized overviews at varying scales can be generated
from a collection of raster fi les and served
using the ArcGIS Server 10 Image extension.
Th is provides a visual presentation of the full
extent of the source data while still making
raw values available for analysis or query.
Th rough the Image Analysis window in
ArcGIS Desktop 10 and other geoprocessing
tools, users can manipulate the raw raster
values served through ArcGIS Server as if the
data resided locally. Using the tools in the
Image Analysis window to create a subset of
data from a service is far more intuitive than
working with the complex processes associated with handling raw image fi les. Users
aren’t constrained; their analytic or display
needs can be met using these raster-based
services.

 The Image Analysis window was utilized

to clip a statewide image service to the view
window on the fly and masked to the forest
boundary without storing the result locally.
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The ability to develop new services by
integrating existing services is an important aspect of this service-based architecture. Alternative outputs are derived
in real time from the same source. Slope,
aspect, hillshade, and topographic convergence services can be derived from a single
elevation service without duplicating data.
Th is concept of reference mosaic datasets
extends to combining a hillshade service
with a simple basemap service to create a
topographic basemap service. Th is service
of services approach is not only highly efficient, it retains the workflow. If one of the
components in the workflow is enhanced, all
downstream components immediately benefit from that enhancement without having
to be re-created. Image services published
through ArcGIS Server 10 Image extension
are also a recognized data type within the
mosaic dataset.
The University of Montana also hosts
the Montana Climate Office, which is pursuing the delivery of statewide climate
products. Time is a component of climate,
and the ArcGIS 10 environment supports
time at both the desktop and service levels.
Delivering raster-based time series climate data gives the end user the capability to query the service based on time. The
Montana Climate Office is anticipating the
production of statewide climate products
on a daily basis. Meeting user expectations

would be extremely difficult without timeenabled raster services provided through
the ArcGIS Server 10 Image extension and
the efficiency of ArcGIS Desktop 10 products
in utilizing those services.

Support for Smaller Projects
The deployment of raster services does not
always have to be large in extent or complex.
The University of Montana also hosts the
State Arboretum on the Missoula campus.
The arboretum uses the City of Missoula’s
4-inch resolution imagery, as well as historic
imagery, to document change over time.
Correctly configuring image services for
even small raster collections can boost delivery performance for end users. Th rough
image services, imagery can be provided
to other campus users in other domains
without giving them direct access to source
fi les. In addition, the same mosaic dataset
used as input to an image service can also
be used as input to a map service. Th is
provides the foundation for delivering services that merge lower-resolution imagery
outside the extent of the City of Missoula
imagery. From the user perspective, this
provides a seamless visual context and
leverages high-resolution or higher-quality
imagery where it exists. In the near future,
this same foundation will support delivery
to mobile devices and even virtual tours of
the State Arboretum.
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The Lubrecht Experimental Forest is a 28,000-acre operational and research forest dedicated to the advancement of natural resource knowledge through research and education.

The University of Montana also hosts the
Lubrecht Experimental Forest, a 28,000acre operational and research forest. Th is
location has limited Internet connectivity,
so the ability to provide oﬄ ine access to
cached imagery is an important consideration for field operations. Even more important is the ability to deliver operational information via services hosted on the main
campus. An extensive lidar research effort
produced high-resolution raster datasets for
ground surface, canopy cover, and canopy
height. These high-resolution datasets can
be delivered to remote operations even
though both internet and intranet connectivity is less than ideal.

The use of ArcGIS 10 offers a software environment that reduces the overhead in delivery of raster datasets that vary in format,
bands, data type, resolution, and extent. It
provides a richer experience to end users who
operate under a wide variety of conditions
and enables a foundation of services that can
be leveraged as new needs arise.
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The top 10 reasons to use them
By Colin Childs, Esri Writer

Terrain datasets in a geodatabase can help
effectively manage, process, and integrate
massive point collections of the 3D data that
result from collecting high-resolution elevation observations using lidar, sonar, and
other technologies.
Terrain data is usually expressed as a
series or collection of points with x-, y-, and
associated z-values. It generally includes a
series of points representing the high and
low extremes in the terrain that define topographic features such as streams, levees,
ridges, and other phenomena.
With ArcGIS 9.2, Esri introduced the terrain dataset to better handle surface data.
This multiresolution, triangulated irregular
network (TIN)-based surface is generated
using measurements stored as features in
geodatabase feature classes. TINs are assembled from a series of data points with x-, y-,
and z-values and partition geographic space
into contiguous, nonoverlapping triangles
(called faces). The nodes of each triangle have
an x,y coordinate and a z-value representing
the elevation or surface value at that location. Using the TIN, any surface value can be
interpolated within a face or along an edge.
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Additional rules are defined to generate TIN pyramids representing elevation
change.
While there are many reasons for using
terrain datasets to manage surface data,
here are 10 of the most compelling ones:
1. Efficient data storage
2. Effective data management
3. Simple workflow for creating a terrain
dataset
4. Vector-based pyramids for rapid display
5. Improved efficiency with point clustering
6. Optionally embedding point data
7. Support of industry-standard LAS format
8. Extensive collection of geoprocessing
tools
9. Powerful surface analysis capabilities
10. Support for 3D ASCII source data formats

1. Efficient data storage
Terrain datasets scale to handle vectorbased source measurement data such as
lidar, photogrammetric, and sonar data.
Traditionally, ArcGIS uses feature data,
like 3D points, lines, and contours, to make
TINs and grids. These surface storage and
representation methods are not well suited

 Terrain datasets, which live inside

geodatabases, offer many advantages for
managing surface data.

to large collections of mass point data from
sources such as lidar, photogrammetric, and
multibeam sonar data.
An ArcGIS terrain dataset offers a
database-oriented solution for managing
these vector-based source measurements.
Th is is achieved through the use of an updated and efficient TIN-based data structure
that generates a multiresolution surface
that is created on the fly for a given area of
interest and level of detail. The terrain dataset supports point, multipoint, polyline, and
polygon-based features and is seamless, fast,
and scalable.
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2. Effective data management
Terrain datasets and the data used to define
them are stored and maintained in a feature
dataset in a geodatabase. Consequently, the
data management advantages of the geodatabase are available to terrain datasets.
While terrain datasets are supported in
all ArcGIS geodatabase formats, it is important to note that these formats have inherent differences in capacities. An ArcSDE
geodatabase is the most capable format and
is appropriate for terrains involving billions
of points and workflows that use a centralized database to manage source measures
and terrain datasets in a multiuser editing
and versioning environment. File geodatabases can be used for terrains with billions
of points but do not allow multiuser editing.
Personal geodatabases are the least desirable for terrain datasets, and their use should
be restricted to terrains with fewer than
20 million points.
In ArcSDE, versioned terrain datasets
support multiple users accessing different
representations of the terrain for different
projects. What-if scenarios can be modeled
by allowing design edits that model proposed changes to be made without actually
changing the original surface. If the design
is realized, the edits can be posted back to
the source data. Possible editing scenarios
include workflows in which operators are
restricted to editing data layers within constrained areas or workflows in which operators are responsible for edits to individual
layers for unconstrained areas such as all
lidar data.
The terrain dataset references participating feature classes (source measures) that
define how they contribute to the terrain
and maintain the rules specifying how these
source measures are used within the terrain
dataset. Because source measurements are
stored, not a derivative surface, they can be
edited and replaced with more current or
accurate data at any time. Terrains enable
users to own and manage the source data
and derive end-user products as needed.
Edit a terrain by editing the feature

classes that participate in it using standard
editing tools. Simply add, remove, or replace
data referenced by the terrain. Measurement
data can be managed over time, and the terrain dataset can grow as additional or more
current data becomes available.

3. Simple workflow for creating
terrain dataset
Use the Terrain wizard to create a new terrain dataset in a feature dataset in a geodatabase. In the wizard, supply a name for
the new terrain dataset and specify the participating feature classes. In addition, point
spacing information, which is collected for
photogrammetric, lidar, and sonar surveys
and supplied with the source data, can also
be specified.
1. Begin by choosing File > New > Feature
dataset > Terrain dataset from the Standard
menu. In the wizard, define how each participating feature class contributes to the
definition of the surface within the terrain
dataset. Specify a height source and surface

 Because source measurements are stored,

not a derivative surface, they can be edited
and replaced with more current or accurate
data at any time.

feature type. For example, a mass point feature class has a PointZ geometry; therefore,
the Shape field supplies the height source.
2. Define the pyramid type the terrain
dataset. Pyramids allow the creation of a
multiresolution TIN-based surface, which
improves overall efficiency. They are used
as a scale-dependent generalization of the
mass point data. Two options are available: z-tolerance and window-size pyramid
level resolutions. Z-tolerance pyramiding
controls vertical accuracy and thins points
to produce surfaces that are within an approximate vertical accuracy relative to the
full-resolution data.
Window-size pyramiding controls horizontal sample frequency and thins

 Source point and breakline data

Esri provides extensive
documentation in the ArcGIS
Desktop Help files available
at arcgis.com, blog posts, and
web courses that help you
learn use of this data format.

 High resolution

 Low resolution
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points for each pyramid level by sampling
within a fixed horizontal distance and fitting
the data into equal areas (windows), then
selecting just one or two points from each
area as representative. Selection is based on
one of the following criteria: the minimum,
maximum, mean, or both the minimum
and maximum z-value. Optionally, the
window-size pyramid type offers additional
point thinning using a secondary thinning
method.
3. Specify pyramid level properties for the
terrain dataset. A pyramid layer represents
a terrain dataset between its reference scale

a form of scale-dependent generalization—
when displaying a surface.
The vector-based pyramid levels in terrain datasets are similar to raster pyramids
and take advantage of the diminishing accuracy requirements as scales decrease. For
each successive pyramid level, as the accuracy requirements necessary to display the
surface drop, fewer measurements are used,
although the original source measurements
are used in these coarser resolution pyramids. No resampling, averaging, or derivative data is used for pyramids.
Since a terrain dataset deploys pyramid

levels, ArcMap is able to rapidly generate a
TIN surface on the fly at whatever resolution
is needed for the scale of the viewer. In the
case of lidar data, some phenomena tend to
be oversampled so using point thinning filters
to retain only those measurements needed to
represent the phenomena is important.
When displaying terrain datasets, a
terrain layer is created. This layer type is
similar to a TIN layer in some regards, as it
supports multiple renderers. With a terrain
layer, it is possible to color triangles by elevation range, slope, aspect, and hillshade. It is
also possible to see the breaklines, triangle

 In the case of lidar data, some phenomena may be oversampled. Point thinning filters retain only those measurements needed to

represent the phenomena.

and the reference scale of the next coarsest
level. Pyramid level properties can be generated using the Calculate Pyramid Properties
button, added manually, or refined based on
knowledge of the data. The summary dialog
box displays the settings that will be used to
build the terrain dataset. Check the settings
before clicking the Finish button to create
the terrain dataset.
4. Once the Finish button is clicked, a message box appears that shows the progress of
the terrain building process.

4. Vector-based pyramids for
rapid display
Rendering very large TINs is generally difficult, partially due to limitations of hardware, such as video cards, and therefore,
terrains are beneficial in that areas to be visualized are rendered at an optimized resolution. Terrain datasets employ pyramiding—
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 A terrain layer is similar to a TIN layer in that it supports multiple renderers. Triangles in a

terrain layer can be symbolized by elevation range, slope, aspect, and hillshade.
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located in these toolsets:
• Terrain Management (terrain creation
and modification tools)
• Data Conversion (data loading and surface conversion tools)
• Terrain and TIN Surface (terrain analysis
tools)

9. Powerful surface analysis
capabilities
 The ArcGIS 3D Analyst toolbar provides interactive tools for many types of analysis

including the creation of profile graphs.

edges, and nodes of the triangulated surface.
Terrain datasets are supported for reading and viewing at all licensing levels.
However, a terrain can only be created
with the ArcGIS 3D Analyst extension. In
addition, terrain datasets are not directly
supported in ArcScene. The recommended
workflow for displaying terrains in ArcGlobe
is to make a raster from the source terrain
dataset and use this in ArcGlobe.

5. Improved efficiency with
point clustering
Multipoints are often used to manage arrays
of large point collections, such as lidar point
clusters, which can contain literally billions
of points. Using a single row for such point
geometry is not feasible. Clustering these
into multipoint rows enables the geodatabase to handle massive point sets. Clustered
multipoints are highly compressed in file
geodatabases and SDE, which reduces storage and I/O requirements.

6. Optionally embed point data
Despite clustering and compression, lidar
can still require a significant amount of
storage space. An option for large multipoint
feature classes is to embed them within
the terrain dataset as a way to save storage space. Embedding is performed during
the terrain build process. Point geometry
and (optionally) lidar attributes are copied
directly into the terrain pyramid structure.

After the terrain is built, it becomes the container of the points and no longer references
the source feature class. This means that the
source feature class can be deleted, reducing
the storage space required.

7. Support of industry-standard
LAS format
The LAS file format is an open standard file
format for the interchange of lidar data. It is
a binary file format that maintains specific
information related to lidar data and is a way
for vendors and clients to interchange data
and maintain all information specific to that
data. Using a LAS file format avoids some
of the pitfalls associated with ASCII format
points, as the extent, point count, and spatial
reference are contained in the header.
An efficient and cost-effective solution
for utilizing LAS point attributes is to use
them with a query filter during conversion of LAS points to Multipoint. By doing
this, LAS attributes, such as class code or
return number, can be used to extract just
the points needed, and there is no need to
import the attributes.

Surface analysis is sometimes best executed
interactively rather than in batch mode using
geoprocessing tools. The ArcGIS 3D Analyst
toolbar provides interactive tools that create
contours, create the steepest path, create a
line of sight, interpolate point/line/polygon,
and create profile graphs.
Surface analysis involves several kinds of
processing, including extracting new surfaces from existing surfaces, reclassifying
surfaces, and combining surfaces. Some of
the types of surface analysis that can be executed using a terrain dataset include
• Floodplain delineation
• QA/QC lidar data
• DEM/DSM creation
• Slope
• Aspect
• Contours
• Surface differencing
• Intensity image generation
• Thinning/Reducing noise
• Spot interpolation
• Profiling

8. Extensive collection of terrain
geoprocessing tools
The geoprocessing tools that interact with
terrain datasets are kept primarily within
the 3D Analyst toolset and are intended
to facilitate automation through the use
of scripts and models. These 26 tools are
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Best Practices for Creating
and Using Terrain Datasets
1. For lidar data, use LAS rather

 Breaklines

 Lidar

than ASCII formatted data.
2. Because personal geodatabas-

es have a 2 GB limit, use a file or
enterprise geodatabase.
3. Terrain datasets must be stored

in a feature dataset.
4. Use projected coordinates;

geographic coordinates, such
as decimal degrees, are not
supported.
5. Z-values should be in the same

units of measure as the x,y
values.
6. Do not build or perform schema

editing on a terrain in an edit
session.
7. The data in the terrain dataset

should be contiguous.
8. Use terrain dataset groups to

boost performance at smaller
scales.

 Multiresolution Surface

9. Don’t use large single-point

feature classes. Instead, use
a multipoint feature class for
large point collections (i.e., any
collection of more than 500,000
points).
10. Ensure feature classes that

contribute to the terrain dataset
have correct extents.
11. Avoid adding polygon features

using polygon-based SFTypes
where possible; they are more
expensive to enforce than
breaklines.
12. Use as few feature classes as

possible. For example, instead
of using a feature class with
50 features, use one with
multipoint features instead.
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 Low Resolution

 Medium Resolution

10. Support for 3D ASCII source
data formats
The ASCII format for lidar is not generally recommended, but many legacy data
formats often use ASCII as an interchange
medium, and thus this workflow is available.
ASCII source data in XYZ, XYZI, or 3D ASCII
Generate formats can be imported into feature classes using the ASCII 3D To Feature
Class geoprocessing tool. After conversion
to a feature class, this data can be incorporated into a terrain dataset.

 High Resolution

Conclusion
The terrain dataset contributes to effective
workflows with lidar and other mass point
collection data types by providing scalable,
efficient data storage and rapid visualization
and enabling powerful surface analysis.

Special: Managing Imagery
Glossary of Terrain Terms
Anchor point

Anchor points remain throughout all pyramid levels of a terrain dataset. They are never filtered or thinned
away (e.g., benchmarks, bathymetry control points).

Breakline

A line in a TIN or terrain dataset that represents a distinct interruption in the slope of a surface by a ridge,
road, or stream, for example. Triangles in a TIN or terrain dataset may not cross a breakline (i.e., breaklines are
enforced as triangle edges). Z-values along a breakline can be constant or variable.

Clipping polygon

Polygons are used to define boundaries for terrain surfaces when a data area has an irregular shape. Without a
clip polygon, the data area would be convex and produce errors in the surface. The triangulation would create
long sliver triangles while attempting to connect points around the exterior of the area and generate errors in
the surface.

Constrained Delaunay

A constrained Delaunay triangulation method follows traditional Delaunay rules everywhere except along
breaklines. Using a traditional Delaunay triangulation method, breaklines are densified to ensure that the
resultant triangulation remains Delaunay conforming. Therefore, one input breakline segment can result
in multiple triangle edges. Using a constrained Delaunay triangulation, no densification occurs, and each
breakline segment is added as a single edge. (See also Delaunay triangulation.)

Delaunay triangulation

A technique for creating a mesh of contiguous, nonoverlapping triangles from a dataset of points. Each
triangle’s circumscribing circle contains no points from the dataset in its interior. Delaunay triangulation was
named for the Russian mathematician Boris Nikolaevich Delaunay.

Face

In a TIN or terrain dataset, a planar surface of a triangle bounded by three edges and three nodes. Faces do
not overlap. Each face is adjacent to three other faces on the surface. A face defines a plane with an aspect
and slope.

LAS

LAS (spell L-A-S) is an open/published standard file format for the interchange of lidar data. It is a binary
file format that maintains specific information related to lidar data. It is a way for vendors and clients to
interchange data and maintain all information specific to that data.

Lidar

Lidar (light detection and ranging) is a remote-sensing technique that uses laser light to densely sample
the surface of the earth with x,y,z measurements. Lidar datasets produce mass point datasets that can be
visualized and analyzed using a terrain dataset.

Mass points

A dataset containing points that are typically derived from data sources such as lidar, sonar, or
photogrammetric data.

Node

One of the three corner points of a triangle in a TIN or terrain dataset, topologically linked to all triangles that
meet there. Each sample point in a TIN or terrain dataset becomes a node in the triangulation that can store
elevation z-values and tag values. Tags represent user-defined criteria about area.

Overview terrain

The coarsest representation of the terrain dataset, it is designed to draw rapidly when the display is zoomed
at or beyond its full extent.

Point spacing

The most common distance between points used to construct a terrain dataset.

Sonar

Sonar (sound navigation and ranging) is an underwater mapping technique that uses sound waves to map the
shape of the ocean floor. Sonar datasets produce mass point datasets that can be visualized and analyzed
using a terrain dataset.

Surface feature type

Defines the role the feature class plays in defining the terrain dataset surface. The surface feature type (e.g.,
mass points, breaklines, various polygon types) are indicated when a feature class is added to a terrain.

Terrain dataset

A terrain dataset is a multiresolution, TIN-based surface built from measurements stored as features in a
geodatabase.

Terrain pyramid

Levels of detail generated for a terrain dataset to improve efficiency. Terrain pyramids are generated through
the process of point reduction or point thinning to reduce the number of measurements needed to represent
a surface for a given area. Two pyramid types exist: z-tolerance and window size.

Triangle

A face on a TIN surface. Each triangle on a TIN surface is defined by three edges and three nodes and is
adjacent to from one to three other triangles on the surface. TIN triangles can be used to derive aspect and
slope information and can be attributed with tag values. Tags represent user-defined criteria about area.

Triangulated irregular
network (TIN)

A vector data structure that partitions geographic space into contiguous, nonoverlapping triangles. The
vertices of each triangle are sample data points with x-, y-, and z-values. These sample points are connected
by lines to form Delaunay triangles. TINs are used to store and display surface models and as a background
structure built on demand by terrains.

Window-size pyramid

The window-size pyramid type thins points based on horizontal sample density.

Z-tolerance pyramid

The z-tolerance pyramid type thins points based on vertical accuracy constraints.
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Changing Lanes
Converting DS Map Books to
ArcGIS 10 Data Driven Pages
By Mike Price, Entrada/San Juan, Inc.

What You Will Need
1.

ArcGIS Desktop 10 (ArcView, ArcEditor, or
ArcInfo license)

2.

Sample dataset from esri.com/arcuser

3.

ArcGIS Maplex extension (optional)

4.

ArcGIS Desktop 9.3 (optional)

Hands On
ith the release of ArcGIS 10, public safety mappers have
a new technology called Data Driven Pages (DDP) to
create and manage information within tile pages. This
exercise presents a standardized methodology to convert an existing ArcGIS 9.3 DS Map Book series into an ArcGIS 10 DDP map book.
This is a sequel to “Finding It Fast: Deploying better map books for
emergency responders” in the Winter 2008 issue of ArcUser magazine,
which presented procedures for preparing and printing map books
for public safety personnel. This tutorial used ArcGIS Desktop 9.3
and an Esri developer sample called DS Map Book to generate and
print multiple pages with extents of one mile and one-quarter mile
square located in Fire District 21 in Whatcom County, Washington.
Map pages were exported as individual Adobe PDF files that could
be printed and bound in map books. These files were also prepared
so they could be indexed, loaded, and displayed on mobile data
terminals in fire apparatus. The pages used best available data and
simple labeling to quickly display street names, address numbers,
water supply, and other features.
This exercise uses actual fire district mapping data (simplified
and synthesized where appropriate) and expands the western extent
of District 21 to include nearly 60 square miles. It adds and refines
many data layers to create complex—yet useful—map documents
that are included in these maps. The ArcGIS Maplex labeling extension (if available) can be used for carefully placing text labels.

MXD files. MapBook_SquareMile_Maplex uses the ArcGIS Maplex
labeling extension. The other file uses the standard Esri labeling
engine. If possible, use Maplex for this exercise. A 60-day evaluation
copy of the ArcGIS Maplex extension is available.

 Use the setup wizard to define the basic characteristics of DDP.

Mapping Data
Several recent ArcUser articles have presented summaries of data
often used by public safety mappers. Using ArcCatalog, preview
the feature classes within the MapBookData file geodatabase.
Refer to MapBookDatasets.pdf, included in the sample dataset. It
shows District 21 datasets summarized by data type and source.
After reviewing this list, think of similar data available locally. Use
ArcCatalog to preview the layer files for these data. Look at the One
Mile Map Tiles that were used to create our DS Map Book series and
will be used in ArcGIS 10.

Looking at Data in ArcGIS 9.3

 This exercise shows how to take a map book created in the DS

Map Book sample and port it over to Data Driven Pages in ArcGIS 10.

Getting Started
The DS Map Book developer sample has been used for nearly 10 years
to compile, manage, and print digital and paper map book pages.
Although very robust, the sample had some shortcomings and occasionally required scripting or workarounds to produce adequate
maps. DDP was developed in ArcGIS 10 to replace DS Map Book and
standardized the building, managing, and exporting of map book
pages not only for first responders but also for anyone needing a map
series development tool.
To begin this exercise, download the sample dataset from the
ArcUser website at esri.com/arcuser. Unzip this dataset and preview
the contents in ArcGIS 10 ArcCatalog. This training set contains two

This portion of the exercise is optional. If a copy of ArcGIS Desktop 9.3
and DS Map Book are available, start ArcMap, copy the dataset, and
open the file MapBook_SquareMile_Maplex.mxd (or MapBook_
SquareMile_NoMaplex, if Maplex is not available). [If ArcGIS 9.3
Desktop is not available, skip down to the next section, Look at a DS
Map Book Page.]
This map document displays tile B19, the busiest map in the study
area. Examine the order of data layers in the data frame. The datasets
in Table 1 are listed in the table of contents (TOC). If DS Map Book is
installed and loaded, you should see the Map Book tab at the bottom
of the TOC. Switch to this tab and explore the 59 map tiles in this
project. The challenge: present each tile in DDP.
In the TOC, open the properties for One Mile Map Tiles under the
General tab. Notice that the reference scale is set to 1:8,400. This is
the presentation scale and is required by Maplex. Click the Data
Frame tab and notice that Extent is set to Automatic. Although setting the DS Map Book scaling was not needed, in ArcGIS 10 it will
be required. While on the General tab, notice that the Label Engine
is specified (either Esri Maplex Label Engine or Esri Standard Label
Engine).
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Installing Data Driven Pages
Open MapBook_SquareMile_Maplex.mxd
(or MapBook_SquareMile_NoMaplex) in
ArcGIS 10. Inspect tile B19 and verify that it
looks like the sample PDF just previewed.
This map just happened to open to a layout
displaying tile B19 in both the One Mile and
Indicator frames. This could be exported
right now, but what would happen if another
tile is selected?
To install the Data Driven Pages toolbar,
right-click in the open toolbar area at the
top of the map document and select Data
Driven Pages.

Getting a Fix on Sliding Scales
Remember the importance of setting reference and data frame scales? Let’s establish
some safety procedures to keep our maps
 Tile B19 is the busiest map in the study area. Examine it in both DS Map Book and DDP.
on the road. In this exercise, the one-squaremile tiles must fit on a letter size (8.5” x 11”)
Open properties for the Local Indicator data frame. This frame printed page in portrait orientation. To efficiently display and label
manages the location or index map that is shown at the top of the one square mile of data with minimal overlap, a 1:8,400 scale for the
layout. In DS Map Book, both Local Indicator and Identifier Layer data frame works quite well.
are reserved names. Changing these names destroys the map series.
Before creating DDP, right-click the One Mile Map Tile data frame
Notice that its reference scale is 1:100,000 and its Data Frame scale and choose Properties. Click the Data Frame tab and set Extent to
is also 1:100,000. In ArcGIS 10, the data frame scale must be allowed Fixed Scale and Scale to 8,400.
to float. These are two important differences between map books in
After setting the scale, preview the data and the supporting atArcGIS 9 and ArcGIS 10.
tribution. Check out the Local Indicator data frame, too. Select carContinue exploring data in ArcGIS 9.3. Verify there are no broken tographic elements and see how they behave. With a few exceptions,
data links and that all links point to the MapBookData geodatabase. the map document continues updating, but panning around in the
Load the Labeling toolbar and look at the labeling rules. Properly One Mile Map Tile data frame (oops, the scale is now locked) reveals
placing text on a complex map book page typically requires testing the index map and title are out of sync. We must fix this. Do not save
and customized rules.
the project just yet because a few changes should be made.
In the original project, lots of time was spent creating labeling
rules. It would sure be nice if these rules transitioned from ArcGIS 9.3
to ArcGIS 10. Can you think of a few things that might not translate
directly into ArcGIS 10? (Hint: There are only three, and they are all
cartographic or cosmetic objects placed outside the map frames.)
Remember the creeping scales in the DS Map Books sample? This
issue was sidestepped by converting the scale bar to a graphic object,
but that locked in one display scale. Wouldn’t it be nice if scale bars
became dynamic in DDP?

Look at a DS Map Book Page
To show how similar (or different) map book pages are in DDP, one
DS Map Book tile was exported so it can be compared to a DDP page.
It is tile WC_B19_093, located in \MapBook\MapBookPages\. Using
Windows Explorer, locate and open this file in Acrobat Reader. Look
at the Layers tab and notice the amount of information stored in this
page.
If you have been looking at the DS Map Book project in ArcMap 9.3,
it is no longer needed, so close it without saving the project.
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 Insert a new dynamic scale, making it the same size as the original.

Hands On

Opening and Testing DDP
With ArcMap 10 started and MapBook_SquareMile_Maplex.mxd or
MapBook_SquareMile_NoMaplex open, start configuring DDP.
1. On the Data Driven Pages toolbar, locate and click the leftmost
DDP Setup button. In the DDP setup wizard Definition tab, check
Enable Data Driven Pages; under Index Layer, set Data Frame to
the One Mile Map Tile, Layer to 1 Mile Map Tiles, and both Name
Field and Sort Field to LABEL. Check Sort Ascending. By carefully
predefining and building a countywide map tiling and indexing
scheme, this same setup could be used anywhere in Whatcom
County. Leave all other settings on the Definition tab unchanged.
2. Switch to the Extent tab. Set Map Extent to Center and Maintain
Current Scale. If this selection is grayed out, return to the
Definition tab and verify that Enable Data Driven Pages is checked.
To print tiles at varying scales, the scale is a tile attribute. For this
series, the scale fits all.
3. Click OK on the Setup Data Driven Pages dialog box and watch
the Data Driven Pages toolbar’s Show Name window. Wait while
the series finds its extent and builds the map pages. When finished, the One Mile Map Tile data frame pans to A19, the first tile.
However, the Local Indicator and map title remain unchanged.
4. Use the Data Driven Pages toolbar to make sure the page is
set on tile A19. The link to the Local Indicator and map title
are certainly broken. Since the DDP is behaving reasonably
well, let’s save the map as a new ArcGIS 10 document, calling it
MapBook10_SquareMile_Maplex.

 Choose Alternating Scale Bar 1.

Installing and Calibrating Dynamic Labels
DDP uses dynamic text to link specific information to each map tile
so a dynamic label should be set for the map name and the map revision date. The scale from the old map book, which is a graphic object,
should be replaced with a dynamic scale.

 The next task is to fix the link between the Local Indicator map

and the map tile displayed.

1. Individually select the map name (B19), the scale graphic, the revi-

sion label (Revised:), and the revision date (11/10/2010) and move
them just outside the active layout, but do not delete them (yet).
2. To set the appropriate map name, choose Insert > Dynamic Text >
Data Driven Page Name from the standard menu.
3. Choose Edit > Select All Elements and look very closely at the
center of the map tile to locate the tiny A19. Deselect all elements
and select the A19 label. Move it to the upper right.
4. Double-click the A19 label to open it and change the label alignment to right-aligned. Note the dynamic expression in the Text
box and select Change Symbol. Note the colors and fonts. Set the
text to 60 point, bold, italic, and Lapis Lazuli (dark blue). Click OK
twice to apply and reposition the corrected label.
5. Now let’s insert a dynamic scale. Choose Insert > Scale bar >
Alternating Scale Bar 2. Click Properties. On the Scale and Units
tab, change the number of subdivisions to 2. On the Format tab,
set all text symbols to 10 points and bold. Click OK. Place the new
dynamic scale below the map name and stretch it to show the full
width of 2,000 feet.
6. Drag the old scale bar under the new scale. If they are not identical
in size, carefully check the data frame scaling. Once the new and
old scale bars match, delete the old scale bar and the old map name.
7. Because map book pages are frequently updated or replaced, the
current revision date should appear for every page. Tiles are often
updated in small groups, so the attribute table for One Mile Map
Tiles has a field called [DATE_MODIF] that can be used to track
changed tiles. Since the sample is a new map book series, another
date appears on all tiles. Dynamic text will be used to replace this
date on the map.
8. Once again, choose Insert > Dynamic Text > Data Driven Page
Name. Select the same tiny A19 in the center of the tile, drag
it to the lower right part of the tile, and double-click to open it.
In the Text box, change the formula to read <dyn type=“page”
property=“DATE_MODIF”/>. Right-align the text, change the font
to 12-point bold italic, then click OK twice to apply. Reposition the
text, verify the new date, and delete the previous text string date.
Save the document.
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2. Navigate through a few more tiles to check these changes. Review

tile F19, which shows dense development around a resort area.
The Quarter Mile Map Tile labels suggest that this dense page
could be later subdivided and printed at a larger scale to show additional detail. Save the map.

Printing a Map Series

 Use dynamic text to display the contents of the DATE_MODIF

field on the map tile.

Fixing the Local Indicator
The original index map named Local Indicator was built and aligned
in DS Map Book, so a few more things should be reset:
1. Right-click the Local Indicator Data Frame and activate it. Choose
Properties.
2. Click the Data Frame tab. In the Extent section, note that the scale
is locked at 1:100,000. This worked in ArcGIS 9.3 but will not work
in ArcGIS 10. Set Extent to Other Data Frame and specify One
Mile Map Tile for Derive extent from another data frame’s extent.
Set Margin to 3000 and Specify Using to Map Units. Click OK.
3. Under Extent Used by Full Extent Command, choose Other. Click
the Specify Extent button and verify that Current Visible Extent
is selected. Click OK.
4. Click the Extent Indicators tab and move One Mile Map Tile into
the Show extent indicator box. Click the Frame button and change
the border color to Lapis Lazuli. Click OK
once to apply extent indicators.
5. Click the General tab and change Name
from Local Indicator to Map Index. Click
OK. The index map should be repositioned
to center on the A19 tile. Clear all selections to highlight only A19. Save map.

After reviewing the DDP map document, let’s print pages:
1. Select File > Export Map from the main menu.
2. In the Export Map wizard, select Export to \MapBook\
MapBookPages and name the series WC. Specify PDF for Save as
Type and set Resolution to 150.
3. Open the Format tab and check Embed All Document Fonts.
Switch to the Pages tab and specify All (59 pages).
4. Click Save to start the engine. Printing 59 tiles will take a few minutes, so take a break.
5. When printing is finished, use Windows Explorer to navigate to
\MapBook\MapBookPages. Locate copies of WC_B19 and WC_
B19_093, open them in Acrobat Reader and inspect both map
pages. Look for similarities and differences.

Summary and Acknowledgments
Map books created with the ArcGIS 9 DS Map Book can be converted to ArcGIS 10 DDP.
The author thanks Whatcom County, Washington, Fire District 21
and Whatcom County GIS/administrative staff for providing the excellent source data. He is also grateful to Esri Technical Support for
technical assistance and help in developing this exercise.
Visit esri.com/arcuser for additional resources.

Taking a Test Drive
To test these pages, use the Show Name box
on the Data Driven Pages toolbar to travel
around the district map. To quickly navigate
between tiles, just type a location code into
the Show Name box. (Hint: Use index map
labels to quickly reposition adjacent tiles.)
Before printing this map series, let’s make
two more quick changes.
1. In the renamed Index Map frame, rename
Identifier Layer 1 to Mile Map Tiles.
Reactivate the One Mile Map Tile data
frame and turn on labels for Quarter Mile
Map Tiles.
 When finished, compare PDFs generated by the DS Map Book (left) and DDP (right).
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Hands On

More Ways to Organize Information
ArcGIS 10 introduces a new, flexible way to
manage additional information related to features on a map. Attachments can store multiple supporting files, such as images, PDFs, or
text documents, in a geodatabase and make
them accessible through map features.
Attachments can be viewed in several
ways: from the Identify window, in the attribute table window, and as HTML pop-ups
as well as in the Attributes window while
creating and editing an attachment.
Because the link from the feature to its
attachments is maintained in a relationship class, an ArcEditor or ArcInfo license is
needed to create attachments. However, any
license level can view attachments.

HTML pop-ups are a useful way to view
multiple attachments for a feature at the
same time. They work not only in ArcGIS
Desktop but also in web applications,
ArcGIS Explorer, or ArcReader.
Attachments offer an easier way to link
several files with a feature. Because the location of the files is managed by the geodatabase, if the geodatabase is shared through a
layer or map package, the attachments are
automatically included.

documents, or PDFs that will be associated with this feature.
4. After adding the attachment, open it by
double-clicking it or by clicking Open. The
attachment opens with the file’s default
Windows application. If no default has
been selected for that file type, a prompt appears to allow an application to be selected.
5. Files made available in a map as attachments can be saved by clicking Save As in
the Attachment Manager window.

Esri Is Your Total
Solution Provider
Total solutions from Esri can
provide technology you need at
prices you can afford. Esri works
with leading hardware vendors to
provide bundled solutions that include
ArcGIS® Server, ArcGIS Desktop, ArcPad®,
and much more. For example, you can

 View several files with HTML pop-ups.

purchase an ArcGIS Data Appliance or a server, workstation, notebook,
GPS Handheld, or Tablet PC bundled
with ArcGIS software. Custom
hardware-only configurations
are also available to existing
Esri customers.

Copyright © 2010 Esri. All rights reserved.

Creating attachments is straightforward;
ArcGIS handles the details. The first step
is enabling attachments for a feature class.
This prompts ArcGIS to create a new table to
contain the attachments and a new relationship class to manage them.
1. In the Catalog window or in ArcCatalog,
right-click the desired feature class
and choose Attachments > Create
Attachments. This enables attachments
for that feature class.
2. To add attachments, start an edit session
in ArcMap. The Attachment Manager
will be used to add attachments. It can
be accessed either through the Attributes
button on the Editor toolbar or through
the table window by right-clicking the
gray cell to the left of the record that will
receive the attachments and choosing
Open Attachments Manager.
3. Once in the Attachment Manager, click
the Add button, browse to the file to
be attached, and click Add. Repeat the
process for any additional images, text

For more information on promotional offers,
visit esri.com/hardware or call your local
Esri office. Offers are updated frequently.
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POPULATION

D
D
DRIFT

Analyzing the location of population centers over time
By Joseph Kerski, Esri Education Manager

The spatial statistics tools in ArcGIS
give you new ways to look at your data.
Examining geographic phenomena using
mean centers is a powerful tool in spatial
analysis. Imagine your data is on a sheet
that is balanced on the tip of a pencil. The
mean center is the point at which a given set
of features is balanced. The mean center is
constructed from the average x- and y-values
that are stored in feature centroids.
The ability to apply weights to the mean
center in terms of one or more variables inherent in those phenomena makes the incorporation of mean centers even more useful
for instruction and research. The formulas
for the mean center and weighted mean
centers are shown in Figure 1.
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Changes in the mean center of a certain
phenomenon can be analyzed over time.
Perhaps the most common application for
this analysis is the study of the movement
of the population center of the United States
from 1790 to the present. Maps of this phenomenon appear in many geography textbooks. Computing mean center is easy to do
in ArcGIS Desktop because this functionality is part of the spatial statistics tools in
ArcToolbox.

About This Exercise
Th is article provides an introduction to
the concept of mean center analysis as it is

applied over time and space to a historical
dataset. It uses the sample dataset from a
tutorial entitled Population Drift: Mean
Population Center Analysis, available
from ArcLessons (edcommunity.esri.com/
arclessons—search the term “population
center”). More detailed information and
other examples are included in this lesson.
Both article and lesson use the Mean
Center tool in the Spatial Statistics Tools
toolbox to create mean centers, weighted
mean centers, and population mean centers.
The results are used to create a map of population center movement in the United States.
Intermediate GIS skills are required for this

Hands On

What You Will Need
•• ArcGIS Desktop (ArcView, ArcEditor, or ArcInfo license level)
•• Population Drift: Mean Population Center Analysis lesson downloaded
from edcommunity.esri.com/arclesson

exercise. They may be used in teaching
classes from secondary to university graduate level. The 100 questions in the ArcLesson
can be completed as an independent study
or in a classroom setting and require about
three hours to complete. With discussion
and deeper analysis, this time frame can be
extended to five hours.
These materials teach how to calculate
weighted mean centers, select and export
spatial and attribute data, and use GIS to
make informed decisions. The ArcLesson
also encourages additional analysis and
provides insights into the causes and effects of population dynamics, including age
structure, lifestyle, job growth and decline,
rural-to-urban migration, sun belt and retiree migration, and other factors. It also
considers the location of lakes, rivers, highways, and federal lands and how they might
influence population change.

Computing the Mean
Geographic Center for 50 States

 Figure 1: The mean center of population in the United States has shifted over the past two

If the 50 United States could be balanced
on the end of a pencil, in which state would
the mean center be? Test your hypothesis by
using the directions in the following section
to compute the mean center for the 50 states
with Shape_Area as the weight field, storing
the result in your popcenters_lesson geodatabase (gdb).
After downloading and unzipping the
Population Drift exercise archive, start
ArcMap. Open popcenters_lesson.mxd and
open ArcToolbox. As you look at this map,
consider how the projection used to display
a dataset can affect the calculation of the location of the mean center. Is the map projection chosen a suitable map projection to use
for calculating mean centers?
In the Spatial Statistics Tools toolbox,
choose Measuring Geographic Distributions
> Mean Center. Use States as the input
layer and Shape_Area as the Weight Field.
Store output in popcenters_lesson.gdb as

meancenter_50states. During processing,
ArcGIS will warn you that the input feature
class does not contain projected data, but
the tool should execute. Using the Shape_
Area field ensures that you are calculating a
mean geographic center rather than a mean
based on the location of the state centroids.
The results are added to the map.

centuries.

Calculating the Mean Center for
48 States
Next, calculate the mean center for the
48 contiguous states and compare your
result to that for the 50 states. Then run the
mean center tool for the 48 states but leave
the weight field blank, which will simply calculate the mean center of all the features you
are analyzing. The mean center without a
weight field will determine the mean center
of the centroids for those polygons.
1. Choose Bookmark > 48 States to zoom to
this preset extent. Select the 48 states and

rerun the Mean Center tool to calculate
the mean geographic center for the lower
48 states. Choose Selection and check
States to make sure that only that layer is
selectable.
2. Click the Selection tool and select the
48 states. (Note that the state “equivalent”
Washington, D.C., is also selected, but its
area is small and has a negligible effect on
overall mean center calculation.)
3. Rerun the Mean Center tool using Shape_
Area for the weight field. Store the results
in the same geodatabase with the name
meancenter_48states. In what state is the
calculated mean geographic center for the
48 states?
4. Run the Mean Center tool for the 48
states, but leave the Weight Field blank.
Running the Mean Center tool without
anything in the weight field will calculate
the mean center of all the centroids for all
those polygons. Save the result.
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 Start analyzing the movement of the mean

center of population by calculating it for 1790.

Compare the unweighted mean center of
the 48 states to the weighted mean center
and think about how the sizes and locations
of the states in the eastern part of the country versus the western part affect the location of the unweighted mean center.

Analyzing the Movement of the
US Mean Center of Population,
1790–2005
The mean centers just calculated are based
on the total land area for each state. Now
look at the population for each state. States
have always differed widely in total population. Let’s compute the mean population
center, which is a center weighted on the
population for an area, such as a state.
A mean center weighted on population
therefore represents the point location at
which a given area could be balanced, based
on population. If one state contains more
people than another state, the weighted
mean population center will be weighted
toward, or drift toward, the more populated
state than to other states.
1. In popcenters_lesson.mxd, turn on the
State Population 1790 layer. If the 1790
population of the United States could be
balanced on the end of a pencil, in which
state do you think this weighted mean
population center would be?
2. Calculate the weighted mean population
center for 1790 by running the Mean Center
tool again, Use the states_1790_2005 layer
as the input feature class, use POP_1790
for the Weight Field, and store the result as
meancenter_1790 in the same geodatabase.
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Changes in Mean Population
Centers over Time

Looking at Population Shifts
within States

1. Let’s look at the pattern of population

After looking at population shifts in the
United States as a whole, compute population centers for individual states.
County-level data is used to determine
the movement of the mean population
center within individual states rather than
city boundaries because city limits change
much more frequently than county lines.
While some counties did split off from other
counties and others merged or changed
boundaries, overall, county boundaries
changed much less frequently than city
limits from 1900 to 2000. For state-by-state
analysis, 1900 is the earliest year examined,
because prior to 1900, many county lines
were different or nonexistent, and therefore,
the geographic framework we need for the
analysis wasn’t in place.
The ArcLesson examines mean population center drift for Kansas, Colorado, and
Nevada. However, this article looks only
at Kansas from 1900 to 2000 and explores
which direction the mean population center
moved and why.
To explore population shifts over time in
Kansas, activate the Kansas data frame. In

change on the map from 1790 to 2000.
Turn on and off the map layers showing
the state population in 1790, 1850, 1900,
1950, and 2000—one at a time.
2. Open the attribute table for the
states_1790_2005 layer. Right-click each
year field and choose Statistics to obtain
additional insights to the changes in population over the centuries. Several fields
begin with CHG. These fields contain
the percent of change between different
census years.
3. Run the Mean Center tool six
times using the years 1800, 1850,
1900, 1950, 2000, and 2005 using
states_1790_2005 as the input layer and
the same geodatabase as the output. Name
the resultant layers meancenter_<year>
using the appropriate weight fields for the
same year (i.e., POP_1800 for 1800). The
result will be the population center for
each year.
4. To check your calculations, refer to the
USA Population Center Movement graph
in Figure 2.

 Figure 2: Use USA Population Center Movement to check

calculations on mean center movement.

Hands On

and federal lands and population in 2000 by
county in this state as well as conduct some
research about the settlement, economy,
and population of Texas from 1900 to 2000
to examine why the mean center of population moved from 1900 to 2000.

Exploring More

 Using Shape_Area as the weight field ensures that mean geographic center is being

calculated rather than a mean based on the location of the state centroids.

1900, Kansas was still being settled by the
pioneers who had traveled there by wagon a
generation before and now were arriving by
railroad, drawn by the promise of cheap land.
It was still heavily dependent on the major
activity that had attracted most settlers
to the state in the first place—agriculture.
Initially, eastern Kansas was settled by immigrants from the eastern United States, followed by the settlement of western Kansas.
As the twentieth century wore on, several
things happened to slow the population of
the central and western agricultural areas
in particular. First, the Dust Bowl of the
1930s caused many people to leave the state
or abandon agriculture and move to larger
towns and cities. Second, the rise of agribusiness and the decline of family farms meant
that fewer people were required to live on
agricultural lands. Urban areas in Kansas
became more diverse. Aerospace companies located in Wichita, and vibrant college
towns such as Lawrence and Manhattan
continued to attract people to the state, but
at a slower rate than for other states.
The map thematically maps population for
cities and counties. The mean center of population in Kansas is shown by the red line in
east-central Kansas in more detail, moving
west, then reversing direction to head east.

Analyzing Mean Population
Centers for Other States
You can analyze the movement of mean
population centers over time for other
states without clipping the counties and
other layers and placing them in separate
data frames. These steps describe how to
analyze another state, Texas, using Select By
Attributes.
1. Activate the USA data frame. Choose
Selection > Select By Attribute. In the
dialog box, choose counties_1900_2000
for Layer and Create a new selection for
Method and create the expression “STATE
_NAME” = ‘Texas’ in the text box.
2. Run the Mean Center tool for 1900 for
Texas using counties_1900_2000 as your
input layer. Write the result to the same
geodatabase and name the output feature
class meancenter_tx_1900.
3. View the mean center that has just been
calculated by adding the meancenter_
tx_1900 layer to the map. Run the mean
center tool once more for each census
year: 1910, 1920, 1930, 1940, 1950, 1960,
1970, 1980, 1990, and 2000.
After running the Mean Center tool for
each census year, the related ArcLesson
encourages the student to describe the
spatial pattern of cities, highways, rivers,

The ArcLesson Population Drift: Mean
Population Center Analysis provides more
questions for exploring this data using the
Mean Center tool in the Spatial Statistics
Tools toolbox. Questions posed in the lesson
invite a detailed analysis of the change experienced by each state. The lesson contains
100 questions that can spark discussion and
new lines of questioning.
The mean center can be calculated from
point, line, or polygon features and used for
many types of analyses. The mean center
of a set of soil samples, the mean center of
asthma patients in a city, and the mean
center of gas wells in a basin are three of a
myriad of types of data that could be analyzed using these easy-to-use but powerful
tools.

 Use Select By Attributes to analyze the

movement of mean population centers for
individual states without clipping data.
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Link a Graph
to a Time-Aware Map Layer
By Earl Sarow, Esri Technical Marketing
Using the new Time Slider and time-aware map layers introduced in ArcGIS 10 with previously existing
charting and graphing capabilities, you can watch your data as it transforms over seconds, minutes,
hours, days, or even years through animating a map layer and any graph derived from it—simultaneously.
Although this sounds complicated, it’s actually quite simple to do.
Making a Time-Aware Layer
This article walks the reader through the
creation of a time-aware graph. It uses a
map layer that contains a series of position reports for Hurricane Ike, which occurred in the Gulf of Mexico in 2008. Each
point feature has a date/time stamp and
an estimate of the maximum wind speed
at that time.

Step 2: Configure the Time Slider Tool
The Time Slider tool is located on the
ArcMap Tools toolbar. Open the Time
Slider tool, open its property page, and
click the Time Extent tab.
The full time extent is set to the time
extent of the Hurricane Ike map layer. The
Start and End times have automatically
been set to match the first and last position reported in the map layer. In the example, it is switched to the Time Display
tab. Because the position reports are
spaced about six hours apart, set the time
step interval to six hours and close the
Time Slider property page.

 Set basic graph properties in the first

wizard panel.

Making a Time-Aware Graph

 Set the map layer’s time properties.

Step 1: Set the Layer’s Time Properties
From the map layer’s property page,
select the Time tab and check the box
labeled Enable time on this layer. For
Layer Time, specify that the features have
a single time. Set Time Field to the field
containing the date stamp information,
which should be in date/time format.
To view the hurricane positions day
by day, set the time step interval to one
day. To see the current location of the
hurricane, along with all its previous locations, check the box marked Display data
cumulatively.
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Now that the layer is time aware and the
Time Slider tool is configured to display
that data, the next step is to make the
graph. The graph will inherit the time
properties of the layer it’s based on, so
this step is pretty straightforward.

 The vertical area graph based on the

time-aware layer will inherit the time
properties of that layer.

Step 1: Create the Graph
On the Standard toolbar in ArcMap,
choose View > Graphs > Create to start
the Graph Wizard.
In the first wizard panel, set some basic
properties for the graph. Set the graph

 Use the Advanced Properties and

uncheck automatic scaling.

type to Vertical Area. Base the graph on
the Hurricane Ike map layer and use the
MaxWindMPH field from that layer as
the Value field. Set the x-axis from the
PositionTime field of that layer. Turn off
the graph legend, match the graph color
to the layer color, and make other cosmetic changes if desired. Click Next.
The second wizard panel controls the
graph’s appearance. Set the graph title to
Maximum Windspeed, set the title for the
vertical axis to Miles per Hour, and set the
title for the bottom axis to Report Time.
Click Finish to close the wizard and open
the graph.

Hands On

 Wind speed as Hurricane Ike approached

the Dominican Republic

 Note the increase in wind speed as the

hurricane crosses Cuba.

Step 2: Lock the Graph Axes
By default, the horizontal and vertical
axes of the graph will rescale to fit the
data in response to the Time Slider tool.
Both axes’ scales need to remain constant,
so the next step is to lock them.
Right-click the graph and select
Advanced Properties from the context
menu. In the Catalog tree, select Left
Axis to open its property page. Select the
Scales tab, then the Options tab. Disable
the automatic scaling for this axis by unchecking the box labeled Automatic.
Click the Minimum tab. Click the Change
button and set the value for Minimum
Miles Per Hour to zero. Finally, select the
Maximum tab and set the upper value for
the left axis to 150 Miles per Hour.
Follow this procedure to lock the minimum value for the bottom axis to the date
and time of the first report and the maximum value to the date and time of the
final report on 9/14/2008 at 3:00 p.m. Now
the graph display can be manipulated
with the Time Slider tool.

Run the Time Slider

 Wind speed dropped off once the hurri-

Open the Time Slider tool and set it to
display the location and wind speed
of Hurricane Ike as it approached the
Dominican Republic. Modify it to show
the wind speed increase as Hurricane
Ike crossed over Cuba. Finally, move the
Time Slider tool to the time Hurricane Ike
made landfall at Houston and began to
diminish as it moved onto the continental
United States.

cane began moving across the continential
United States.
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GIS Bookshelf
Jacquard’s Web: How a Hand Loom Led to the Birth of the
Information Age
By James Essinger
In this skillful blend of history, biography, science, and technology, James Essinger shows
how the technological innovations that created the first programmable loom led to the
emergence of digital computers. The brilliant nineteenth-century scientist and mathematician Charles Babbage recognized that the concepts embodied in the punched cards
Joseph-Marie Jacquard used to automate the weaving of threads of silk into elaborate
patterns could be used to weave information. His Analytical Engine was designed to reliably perform the formidable calculations needed to further scientific inquiry. Despite the
brilliance of his concept, Babbage struggled to obtain recognition and funding for the
project, and it was never completed in his lifetime. Without the determined efforts of Ada
Byron, Countess of Lovelace (better known today as Ada Lovelace), in promoting and
explaining the work of an increasingly cranky and reclusive Babbage, later generations
might not have known about it or appreciated its value. It was left for Herman Hollerith
to make Babbage’s vision a practical reality and IBM to make it a commercial success.
Jacquard’s Web is a thought-provoking and entertaining tale that traces the information
revolution of the twentieth century to its roots in 1804. Oxford University Press, 2007, 320
pp., ISBN: 978-0192805782

Disease Maps: Epidemics on the Ground
By Tom Koch
In a sense, Disease Maps: Epidemics on the Ground is the prequel to Tom Koch’s 2005 book
Cartographies of Disease: Maps, Mapping, and Medicine. In the first book, Koch examined
the relationship between medical mapmaking and medicine and GIS. In this soon-tobe-published book, he advances the idea that physicians, scientists, public health proponents, and others, used maps as a “workbench” to develop and test theories of disease.
Understanding disease begins with the visualization of its occurrence not as a personal
event but as a public one that must be considered in context and responded to through
communal action. This premise is discussed using maps of disease outbreaks on scales
from local to international and from the seventeenth to the twenty-first centuries.
Read a more complete explanation of the theme of this book in “Visualizing Disease:
Understanding epidemics through maps” in this issue. This book is currently slated for
publication in May 2011. University of Chicago Press, 2011, 368 pp., ISBN: 978-0226449357

Why ‘Where’ Matters: Understanding and Profiting from GPS,
GIS, and Remote Sensing; Practical Advice for Individuals,
Communities, Companies, and Countries
By Dr. Bob Ryerson and Dr. Stan Aronoff
In the emerging Geo-Economy, the authors maintain that understanding the converging
geospatial technologies of GPS, GIS, and remote sensing is essential to countries, companies, and individuals. The Geo-Economy is the economy transformed by the seemingly
insatiable appetite for integrated geospatial information. After tracing the use and growing importance of geographic information, the first chapter surveys existing geospatial
technologies and the impact of their convergence on society. The next chapter addresses
the importance of geographic information in formulating effective policies for dealing
with the future. The final chapter prescribes how individuals, organizations, and countries can and should benefit from the use of geographic information. Kim Geometrics
Corporation, 2011, 378 pp., ISBN: 978-0986637605
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Bookshelf

Landmark Text Reissued

A Practical Guide

A primer for exploring and communicating visual data

Tutorials for humanitarian relief


Originally published in French
in 1967, Semiology of Graphics:
Diagrams, Networks, Maps by
Jacques Bertin laid the foundation for information visualization. In Semiology of Graphics,
Bertin attempted to formulate principles of graphic communication
based on his practical experience as a cartographer. These rules were
needed, Bertin believed, because “data is transformed into graphics
to understand. A map, a diagram are documents to be interrogated.”
Last issued in English in 1983, this essential reference for cartographers, graphic designers, illustrators, and geographers had been
difficult to locate and expensive to purchase. With republication by
Esri Press, it is now readily available at a reasonable price. The Esri
Press Classic Series preserves important scholarship in the field of
cartography by republishing seminal texts that are no longer in print.
In a preface to the 1983 translation of Semiology of Graphics,
Howard Wainer emphasized the book’s importance as a guide at a
time when “we were on the cusp of an explosion in the use of graphical methods for both the exploration and communication of complex
data. This prediction came true. In the intervening 27 years a huge
amount of work has been accomplished to help us use graphical
methods profitably.”
As Wainer noted in the preface to the 2010 English edition, if
Bertin’s masterwork had remained in print, some of the current
“graphic ignorance would be ameliorated.” Wainer is a distinguished
research scientist at the National Board of Medical Examiners and
the author of Graphic Discovery: A Trout in the Milk and Other Visual
Adventures.
Bertin, who died in 2010, was a world-renowned authority on information visualization who founded the Cartographic Laboratory
of the École Pratique des Hautes Études, part of the University of
Paris, in 1954. He was named its director of education in 1957. In the
late 1970s, he became head of research at the Centre National de la
Recherche Scientifique.
This edition of Semiology includes more than 1,000 maps and diagrams that illustrate and examine graphic techniques for portraying
shape, orientation, color, texture, volume, and size. The new English
edition includes an epilogue written by the author shortly before his
death that details the historic development of the book. In it, Bertin
speculated on the impact of GIS and other modern technologies on
information design. Esri Press, 2011, 460 pp., ISBN: 978-1589482616


Author Firoz Verjee wrote
this book to encourage the
establishment of formal GIS
programs
for
humanitarian nongovernmental organizations (NGOs). For more than
16 years, Verjee has specialized in the application of remote sensing
and GIS, primarily within the fields of disaster risk reduction and
humanitarian assistance.
GIS is an essential tool for situational awareness to improve the
flow of goods and services to populations at risk. GIS Tutorial for
Humanitarian Assistance focuses on the specific skills needed to support emergency relief efforts, with an emphasis on finding, importing, and managing spatial data in regions with poor infrastructures.
The book begins where introductory books that teach general
GIS theory and practice leave off. Exercises in this text incorporate
specific scenarios and provide strategies for meeting challenges that
humanitarian agencies might likely face. For example, chapters deal
with topics such as generating spatial data during emergencies or
improving the design and operation of refugee camps.
These tutorials also work well for intermediate and advanced
college-level coursework or self-study. “This book provides the core
skills necessary to realize the full potential of GIS in humanitarian
assistance,” according to Verjee. “It builds on the recent experience
of leading GIS practitioners from around the world and establishes
some basic doctrines for the analytic applications of ArcGIS software during humanitarian operations.”
Verjee is a senior research associate at the Institute for Crisis,
Disaster, and Risk Management at George Washington University
in Washington, D.C. He also coordinates Aga Khan Development
Network Seismic Risk Management Initiative, based in Dushanbe,
Tajikistan. The book includes a 180-day trial of ArcGIS Desktop 9.3.1
software on DVD. A CD with data for the exercise is included. Esri
Press, 2010, 380 pp., ISBN: 978-1589482135
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“The successful progression from
globe spinning to geographic critical
thinking is one of our community’s
most important challenges.”

GIS Education Today
An interview with Michael Gould

Editor’s Note: Michael Gould is Esri’s director of education for industry solutions. He earned his doctorate in geography
from the National Center for Geographic Information and Analysis (NCGIA) at the University at Buffalo, New York. Before
joining Esri, he was an interdisciplinary professor of information systems and cocreator of an Erasmus Mundus-funded
geospatial technologies master’s program at Universitat Jaume I, Castellón, Spain. Gould’s research interests include
spatial data infrastructures (SDI), standards-based interoperability, and geospatial web services. He spoke with Esri
writer Jim Baumann about the challenges and opportunities facing GIS educators.

What are the primary challenges
confronting GIS educators today?
Baumann:

Gould: One of the major challenges for all educators—not only GIS
educators, unfortunately—is that education budgets are being cut to
compensate for national and regional financial problems, which they
were not responsible for causing. The trend of being asked to do more
with less cannot continue, and we must stand up to help our educators defend the principle that education is our collective future.
Regarding GIS, one of the major challenges continues to be the
difficulty in explaining to administrators the value of GIS, both for
improving critical thinking in the classroom and for administrative use to save money and improve services such as transportation
and safety and even for fund-raising. Educators who describe GIS as
valuable only for mapmaking will continue to be challenged, so it is
incumbent upon them to shift to these deeper justifications.

How can universities best expose
their students to the advances being made
today in GIS technology with limited funding
and increased teaching loads during this
recessionary period?
Baumann:

Gould: Universities need to understand the entire value proposition
of GIS: an investment made not only for a few students to learn in the
classroom (and get jobs later) but also so that many different departments might stimulate their research activities. GIS also has valuable
administrative uses. GIS software that is hidden away in a single academic department’s classroom will not meet its potential return on
investment [ROI]. This value proposition is not really affected by the
overall economic climate any more than is the value of a microscope
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to biology students. One of the best ways for universities to maximize
ROI is to engage in a university site license, which provides access to
unlimited software, including server products, by all departments for
educational and administrative use. The site license brings down the
cost per seat of software, and this makes it easier for departments
that are not traditionally geoenabled, such as computer science, to
experiment with GIS in their curricula and research projects.
Even at universities that have not yet exploited site licenses, students now have more options than ever to program applications
using GIS components that are freely available, either via open source
projects or the free tools offered by commercial vendors. Over the
past two years, Esri has published a broad suite of free application
programming interfaces (APIs); software development kits (SDKs);
clients such as ArcGIS Explorer; and ArcGIS Online, a cloud-based
environment for publishing and discovering a myriad of geocontent.
Baumann: Can you discuss the importance of
GIS education in the development of critical
thinking skills?
Gould: Simply put, GIS is a critical-thinking platform. The platform’s tools help promote what educational experts call constructivist learning: learning by modeling and building. Rather than merely
reading about how a city is planned and managed, why not model
and build a virtual city using a database and graphic tools? What
are the city’s essential components, and how do they interact with
each other? Then, which fi xes or updates can help improve the performance, sustainability, or livability of the city?
GIS supports a long list of what-if questions about our world—
permitting students to go beyond spinning the globe or zooming
in to see their house—to be able to dig deeper, make quantitative

Education

comparisons, and propose solutions. One of the few things that educators, politicians, and businesspeople seem to agree on is that students
need to learn to become better critical thinkers. Current tendencies
in many countries toward teaching to standardized exams put us at
risk of sliding toward the educational equivalent of fast food, instead
of toward education providing the critical thinking society demands.
A central challenge for the entire GIS field is to demonstrate how GIS
technology, like spreadsheets and general database management systems, can be and is being used as effective critical-thinking platforms
across the entire campus, across the entire curriculum.

What will it take for universities in
general to implement a GIS curriculum or
classes for a wider range of students (those in
disciplines outside the traditional geography
and the earth sciences); that is, how do you
broaden the awareness of the benefits of
using GIS to faculty and students outside the
traditional GIS disciplines?
Baumann:

Gould: One of the keys is to stop treating GIS as a property and
specialty of only the geographer. Nearly all fields of study work in
and within spatial constraints, and all students could use a dose of
the kind of critical thinking that a well-prepared GIS lab exercise
can provide. One way to help them do so is to more widely promote
the open studio medium of instruction, such as that used habitually
by architecture students. Critical thinking and problem solving go
hand in hand with group project work.
Baumann: Which nontraditional disciplines
would be the most appropriate to implement
a GIS track?
Gould: Beyond the traditional fields of geography, planning, and
geosciences, there are several disciplines, such as business, public
health, environmental science, and history, in which we have seen
interesting applications of GIS technology and spatial analysis. And
more computer science departments should experiment with geospatial algorithms, data models, and applications, but of course, this
depends on individual researchers catching the virus.
Baumann: Are there major differences in GIS
education between the United States and
Europe?
Gould: The similarity lies in the more or less common curriculum
being taught on the two continents. The main difference lies in the
stronger job market, despite the economic downturn, in the United
States, which leads to a sense of optimism that graduates of GIS
programs will find a job as long as they are able to move to where
the employment is. There are perhaps 2,000 open positions currently
just in the Washington, D.C.; Colorado; and California regions. This
strong demand is partly due to the comprehension among government and business leaders that GIS is not just for geographers.

Another related difference is the greater degree of competitiveness among US universities to attract the most capable, financially
independent students from around the world. Outside of perhaps the
UK and Germany, I do not see much of this competition in Europe.
Finally, many more US universities have software site (or campuswide) licenses, allowing wider dissemination of GIS across the
campus, whereas European universities are more likely to have just
a few individual laboratories with limited GIS licenses available to
students.
On both continents, many professors are limited users of open
source software, but they also realize that teaching commercial
software better prepares students for professional employment at
organizations that are regular users of similar software. Speaking of
employment, on both continents, professors need to pay greater attention to enterprise workflows, which means less focus on desktop
GIS and more on server, mobile, and web solutions.

How do Esri’s education efforts
affect its overall commercial role and
development/research activities?
Baumann:

Gould: Esri’s history began with close ties to universities. For example, the University of California, Riverside, hosted some of the
early Esri GIS software on its mainframe. Some of the earliest Esri
users were the University at Buffalo (then SUNY-Buffalo) and the
University of South Carolina. The formal Esri education program
started in the early 1990s, and now we have nine specialists working with education users in the United States. There are many other
specialists working at Esri distributors around the world.
Certainly one of the main reasons Esri has such a large and wide
user base is in part due to the fact that these users learned Esri software at universities and now, increasingly, at secondary schools
and through informal education programs also. As far as current
research and development, the universities play four fundamental
roles: Esri developers read their scholarly papers and follow their
output at conferences; Esri hires many of the best GIS program
graduates; Esri has consulting agreements with several of the bestknown academic experts in the GIS field; and the Esri Development
Center (EDC) program provides special recognition and increased
contact with developers to a small set of university research groups
that work in teaching GIS software development.
Recently, Esri began hosting a series of geographic information
science [i.e., GIScience] events at its headquarters in Redlands,
California, aimed at bringing together experts in cutting-edge
fields such as space-time modeling [at an event held February 2010]
and volunteered geographic information [at another event held in
February 2011] as well as smaller specialist meetings on topics of
mutual research and development interest.
I believe that the renewed interest in maps and mapping that has
been inspired by geovisualization software such as Google Earth,
Bing Maps, and ArcGIS Explorer will help drive an expanded use of
fully functional GIS on campus, in both classroom and administrative settings. The successful progression from globe spinning to geographic critical thinking is one of our community’s most important
challenges.
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Show What You Know

Certification recognizes GIS knowledge and proficiency
GIS professionals can now earn technical certifications that recognize expertise in Esri desktop, developer, and
enterprise use of Esri technologies with the new Esri Technical Certification program. Exams are offered worldwide
at 5,000 PearsonVUE (Esri’s global testing partner) locations in 165 countries. Initial certifications include ArcGIS
Desktop Associate, ArcGIS Desktop Professional, Web Application Developer Associate, Enterprise Geodatabase
Management Associate, and Enterprise Administration Associate. Eight more certifications will be added to the
program later in 2011 and into 2012.

How will I benefit from
becoming certified?

What’s the best way to prepare
for an exam?

Top three tips for passing your
exam

In addition to the pride in achieving such an
accomplishment, you will benefit from becoming certified by distinguishing yourself
in the Esri user community. Proving your
competency in using Esri software products
can benefit you if you are seeking employment or advancement in your current position. It also demonstrates your commitment
to understanding and using Esri best practices to employers.

The best way to prepare for an exam is
to review the Candidate Qualifications
and Skills Measured sections on the Esri
Technical Certification website. From that,
you can determine if your skills align with
the listed skills and qualifications. If you
think you may be lacking in certain areas,
review the Training Resources and identify
classes that may help you prepare for the
exam. You can also visit resources.esri.com
and view product web pages, demos, and
PowerPoints at esri.com.
Esri has also introduced two new Skills
Review courses to help you prepare for the
desktop certification exams. In a fast-paced
environment that emphasizes group discussion and hands-on practice, you can review,
apply, and extend your ArcGIS skills. You
will leave class with a good understanding
of the strengths and weaknesses in your
knowledge of ArcGIS, so that any other preparation time you spend will be more focused
and productive. For more information about
these classes, visit esri.com/skillsreview/.

1. Review Candidate Qualifications and

How will my organization
benefit by certifying its staff?
By having Esri-certified staff on hand, organizations are able to clearly demonstrate
to their customers and stakeholders that
they have qualified staff working on GIS projects. In addition to this, the organization
itself may see an increase in customer support satisfaction and an overall decrease in
general operating costs as they relate to GIS.
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Skills Measured to ensure you’re taking
the exam that best suits your skill set.
2. If you identify gaps in your skill set when
compared to the Skills Measured list, seek
out additional training resources to help
you prepare for the exam.
3. Get plenty of rest the day before the exam.
Relax.

For more information
Esri Technical Certification Website:
esri.com/certification

Exam Registration:
pearsonvue.com/esri

Education

Many Reasons to Consider GIS as a Career
Whether you are a student considering your
first career or someone already in the workplace who is considering a new career, choosing GIS can be rewarding in many ways.
The growth potential in this sector has
remained high. As the use of GIS and other
geospatial technologies expands, it offers
opportunities for people with different work
experiences and educational backgrounds.
According to the Geospatial Information
& Technology Association (GITA), because
geospatial technology use is so widespread,
“the geospatial market is growing at an
annual rate of almost 35 percent.”
Although these are compelling reasons to
consider a career in GIS, Joseph Kerski, Esri
education manager, poses some questions
and offers some answers that can help you
appreciate some other reasons why a career
in GIS might be the right choice.

Do you want a career or just a job?
Do you want to be paid for doing something
you love to do or just collect a paycheck? A
career where GIS is a fundamental part of
your day allows you to be immersed in a
field where you can continually grow and
move forward in an environment of lifelong
learning.

Do you want to do something cool?
GIS is an exciting, rapidly changing, and

cool technology that merges nicely with
many other technologies you may be interested in, such as video, web development,
and phone apps.

Do you want to do something
important?
GIS is a green technology that is making a
difference on our planet and to its people
every day for key decisions about wildlife
habitat, human health, renewable energy,
climate change, water quality and availability, wilderness areas, and much more.

Do you love maps?
For thousands of years, maps have been fascinating and powerful sources of information. GIS combines the best of visualization
and technology. Today’s maps are not just
reference sources, they are dynamic, and
you can change them to suit whatever need
you have or problem you are trying to solve.

Do you like to get outside?
GIS depends on data collected in the field.
Your “field” could be atop a glacier, in a river,
on a city street. There is no end to what
needs to be mapped and analyzed.

Do you want to empower people?
The convergence of the web, GIS, and handheld devices make citizen science a reality.
You can contribute to real scientific studies

or build tools to enable citizens to make
these contributions.

Are you curious about your world?
GIS allows you to investigate what-if scenarios, model, ask questions, and investigate
possible outcomes.

Do you care about the well-being
of your local community?
A career in GIS enables you to do something
about issues in your own community: health,
zoning, services, greenways, crime, trash,
traffic, and more.

Do you want to make sense of data?
If you think that a mountain of data exists
now, just wait until next year. GIS helps you
make sense of all that data and to develop
critical-thinking skills to help you understand what data to use and what not to use.

Do you want to blaze new trails?
Many, if not most, of the GIS-related jobs in
the future have not even been invented yet,
so market yourself! Propose a new position
in an organization that you are interested in.
Make your case that you are the one to staff
that position!
For more information, visit the Esri Career
Pathways page at esri.com/industries/
university/business/career.html.

New Esri Authorized Instructors
The Authorized Training Program (ATP) is pleased to acknowledge
the newest class of Esri Authorized Instructors. These candidates
have passed all ATP requirements and have been granted authorization to teach the specified Esri courses within the United States
and United States territories. These instructors join a network of
Authorized Instructors. To locate an Authorized Instructor in your
area, please visit esri.com/atp; contact ATP by e-mail at atp@esri.com;
or call 909-793-2853, ext. 1-2111.
Code

Class

AGD1

ArcGIS Desktop I

AGD2

ArcGIS Desktop II

PAON

Introduction to Programming ArcObjects Using the
Microsoft .NET Framework

Alabama

Maryland

Wubishet Tadesse
Alabama A&M University
Huntsville, AL
256-372-4252
wubishet.tadesse@aamu.edu
AGD1

Gregg Countryman
GIS Solutions Inc.
Baldwin, MD
410-615-1336
Gcountry@gissolutions.com
AGD1

California

Pennsylvania

Thad Tilton
San Bernardino, CA
909-748-0380
thad@tiltongis.com
PAON

Kathleen Cullinane
Concurrent Technologies Corp.
Tobyhanna Army Depot
Tobyhanna, PA
570-650-7604
Kathleen.cullinane@us.army.mil
AGD2
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Visualizing Disease

Understanding epidemics through maps
by Tom Koch

 Figure 1: In his map of Leeds, Edwin Chadwick

included income disparity and disease information to correlate poverty and disease incidence.
Because population data was available from
wards, data was aggregated at that level.

End Notes

Forget
aesthetics.
Maps are the workbench on which ideas are
fashioned in a manner that permits them to
be argued and, often, tested. The workbench may be tidy or messy, depending
on the workman. The real focus is the work
itself. And so it is with maps. A map is not a
representation of work that has been completed but the presentation of arguments
about the relationships between things.
Most maps are not beautiful, and that’s
okay. A map that is dull or plain may do
the job just as well as one that is beautiful.
Sometimes, it does the job better. At least,
that’s the way it is with the maps I care about
and make—maps of disease and its causes.
In 2003, Esri Press supported my desire
to write a book about the history of disease
mapping, an area of study that had been
overlooked. The result was Cartographies
of Disease (Esri Press, 2005). This book tells
a story of maps, beginning in the seventeenth century, that argue the presence of
specific diseases in an environment.
This book took for granted the idea of
disease. Disease Maps: Epidemics on the
Ground does not begin with that assumption. Its subject is how maps have transformed observations of a set of symptoms
(e.g., diarrhea, fever, vomiting) into identifiable diseases that can be studied so their
causes can be identified. Considered from
this perspective, a map is a workbench for
exploring ideas about disease and testing
those ideas in the crucible of a general epidemic or a localized outbreak. Maps permit

the exploration of the relationship between observed incidence and suspected cause.
Maps make many isolated cases into a single class of events that share similar symptoms
and a single diagnosis. Placing events in a map illustrates not only the relationship of
individual events to each other but also the relationships of these events to the physical,
political, and social constructs that define the environment where the outbreak occurred.
Mapping sets the resolution and scale for a given argument about the relationship between disease and the environment. It places these events in context.
From this perspective, maps are about numbers and statistics. Nobody maps a single,
unique event in blank space. When the unique becomes common—when one becomes
a set of 5, 500, or 50,000—an argument can be fashioned and a map constructed. While
once paper, pen, compass, and protractor were used, now typically the mapping tools in
GIS are employed.
Although the history of this process is long, the conclusions are unassailable. Maps
place isolated events into categories that can be used when considering their organization and relationship to the world. The proof lies in any of the many thousands of maps of
disease made over the last several hundred years.

Mapping Disease in the 19th Century
Look at Edwin Chadwick’s famous 1842 map of Leeds, taken from his seminal exploration of the relationship between health and social welfare (Figure 1). Chadwick, a noted
English social reformer, symbolized the streets where the working class, trades people,
and the upper class resided using darker to lighter brown hatching. To this social mapping,
Chadwick added red dots signifying the homes of those who died in the first pandemic
from cholera in the 1830s and dark blue dots signifying the homes of those who reportedly died of respiratory diseases. This permitted him to argue a correspondence between
health and class, as defined by income and mortality. In effect, Chadwick redefined the
disease he mapped as outcomes of social inequality rather than solely of personal habit
or bad luck.
Chadwick’s map would garner little praise from teachers of contemporary GIS today.
The browns used to indicate different classes are too similar and thus difficult to distinguish. The red dots have faded and are hard to see. The dark blue dots are almost black
and fade into the browns. The clutter beneath the legend and the aggregated health
statistics seem, on first glance, to have little to do with the map graphic.
Look, however, at what Chadwick accomplished. This map, based on data returned by
the first modern census (1839), transformed the geography of income inequality into

 Figure 2: This map projects the likely

worldwide decrease in colon cancer
incidence if vitamin D supplements were
used. The reduction is greatest in areas with
least sunlight.
Map courtesy of Frank Garland.
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 Figure 3: This map presents the

researcher’s fundamental insight: there is a
correlation between breast cancer rates and
the degree of sunlight with its strong natural
vitamin D component.

Map courtesy of Frank Garland.

a geography of disease. Chadwick reordered the city streets to present different levels of
income based on employment. To emphasize that data, his map depicted the buildings in
the densely populated core of the city.
To this he added blue and red dots symbolizing the homes of those who had died
of cholera and respiratory disease. As a cause of death, these two had little in common
except their greater prevalence among the poor than the rich. In mapping them, Chadwick
made them equivalent and argued their relation to income.
In those days, nobody was sure what cholera was and how it was distinguished from other
diarrheic conditions. Cholera, cholera morbus, and promontory diarrhea were some of the
many clinical definitions used on death certificates of the day. Chadwick took these disparate mortal diagnoses and made of them all a single class of event (denoted by a red dot)
that he could set against the social determinants he believed influenced cholera mortality.
Similarly, respiratory disease meant many things (e.g., flu, pneumonia). He conflated
these events into a single class that could be presented with cholera events in the landscape of urban employment and income.
Chadwick’s map argued these diseases as outcomes of social failure. Because there
were more dots in the streets with lower income than those with higher income, mortality
was therefore inversely related to income level and income level to employment. The map
was too busy to do anything but suggest this conclusion. However, it served admirably to
suggest this.
From this map and its database (as we would call it today), Chadwick was able to draw a
series of associations that are summarized in his designation of “good” and “bad” streets
in the city’s various districts. Good streets were those with fewer deaths, which resulted
from lower population density and higher income levels. Bad streets were those with more
deaths, which resulted from greater population density and lower income level. Cholera
and respiratory disease thus became markers for a mortality correlated across the landscape of inequalities whose health consequences his map argued.
The map is filled with computations and simple statistics summarized in the legend.
Each death has a location in space—a latitude and longitude. From this information,
myriad calculations can be derived. All this computation took place behind the map to
permit his conclusions about healthy and unhealthy, or good and bad, streets based on
the relationship between income and mortality.
As a cartographic work, the map is probably a failure. As a representation of Chadwick’s
reasoning, the map is somewhat confusing but serviceable. As a workbench on which
Chadwick gathered the elements of his argument and organized the data, the map was
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an astonishing success. Since 1842, thousands of maps have been rendered in many
countries at a range of scales that make the
same argument: the real cause of illness is
often poverty.

Mapping Disease in the
20th Century and Beyond
Few maps stand alone. Most maps owe
their existence to other maps as conceptual
harbingers. Typically, each map contains a
mapped history of an argument’s development. Chadwick’s map of Leeds was based
on an earlier rendering of the city. We do it
a disservice when we call this a basemap as
if it was somehow unimportant to the argument. Through mapping the physical structure of the city and overlaying economic
and medical analytics, the relationship
between these aspects can be understood .
Consider a map created by Frank Garland,
an epidemiologist and professor of family
and preventative medicine at the University
of California, San Diego, and his colleagues
that predicted a potential decrease in colon
cancer rates if vitamin D supplements were
used as a preventive measure. On one level,
the map presents a sophisticated statistical argument for a relationship between
vitamin D and cancer. It calculates the presumed effect of increased use of supplements based on current disease rates and
the assumption these cancers are related to
natural vitamin D from exposure to sunlight.
One would think this is a simple graphic

End Notes

Medicine, Maps, and the World

Maps of disease are
the workbench on
which theories are
cobbled together
and investigated.

summarizing complex statistics that are anything but cartographic.
However, this map is only the latest in a
series of maps. In their first paper in 1984,
Garland and his brother, Cedric, overlaid
gradients of sunlight exposure on county
mortality data for colon cancer Figure 2).
The resultant map showed a strong inverse
relationship between levels of solar intensity and death rates of colon cancer. Later
studies found a similar correlation for
other cancers (see Figure 3) and diabetes.
The Garlands and other researchers have
worked to isolate vitamin D as the active
element in sunlight’s apparent cancer protection and to establish the likely effect on
cancer rates of increased vitamin D supplementation during periods of low sunlight.
The conclusion, promised but not explicit in
these maps, is compelling: over time, a daily
usage of vitamin D supplements would decrease worldwide cases of breast and colorectal cancer by 450,000 cases a year.
In the map, the bars show the projected
percentage of colon cancer prevention.
The argument this map makes is dependent on previously mapped cancer rates.
The Garlands’ map is based on maps of
US sunlight gradients and the apparent
congruence between those isobars and
the mapped incidence of specific cancers.
Hidden in the map—but present in the
thought behind it—is the argument that
changing vitamin D levels effectively reduces cancer rates.

Maps of disease are the workbench on which theories are cobbled together and investigated. However, it is a history that is still only half told. Cartographers have emphasized
the aesthetics and graphic history of their medium but have shortchanged the ideas maps
present. This is not surprising. To see maps as the medium of an increasingly statistical investigation requires knowing something about statistics generally and (more important) about
the statistics of the subject being mapped. Alas, those trained in mapmaking are often not
skilled in handling statistics.
Chadwick didn’t use computerized mapping. Neither did John Snow or the hundreds of
others whose maps of cholera, yellow fever, plague, respiratory disease, tuberculosis, and
other diseases have helped advance our knowledge of disease, health, and pandemic outbreaks. But GIS certainly makes things easier.
GIS doesn’t stand alone, of course. It is the workbench of a range of statistical programs—
from Excel to SASS and SPSS—that permit numbers to be joined to the map. Back in the
1960s, this required large, mainframe computers and old, clumsy Fortran. Today, it still sometimes requires large computers, but most of the work can be done more easily on a laptop.
From then to now, what has not changed is the plasticity of the map as a medium in which
ideas are generated, formulated, and argued using the best tools (graphic and statistical)
available. Because medicine is my area of interest, it is in this area that I researched the
legacy of the map as the workbench of new theories. I could as easily have used the history
of city maps, national maps, air and sea cargo routes, or almost any other subject to make
the same point.
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